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> WARRANTY AND COPYRIGHT

THIS DOCUMENTATION IS COPYRIGHT 2007, NEXT LIMIT SL.

THE MAXWELL RENDER SOFTWARE IS PROVIDED ‘AS-IS’ AND WITHOUT WARRANTY
OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION,
ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.
IN NO EVENT SHALL NEXT LIMIT BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT
OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER
RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF
THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR
IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

COPYRIGHT®© 2007 NEXT LIMIT S.L. THE CONTENT OF THIS MANUAL IS PROVIDED
FOR INFORMATIONAL USE ONLY AND IS SUBJECT TO CHANGE WITHOUT NOTICE.
NEXT LIMIT ASSUMES NO RESPONSIBILITY OR LIABILITY FOR ERRORS OR
INACCURACIES THAT MAY APPEAR IN THIS DOCUMENTATION. ALL PRODUCTS OR
BRAND NAMES MENTIONED ARE TRADEMARKS OR REGISTERED TRADEMARKS
OF THEIR RESPECTIVE HOLDERS. MENTION OF THIRD-PARTY PRODUCTS IS FOR
INFORMATIONAL PURPOSES ONLY AND CONSTITUTES NEITHER AN ENDORSEMENT
NOR A RECOMMENDATION.

ALL RIGHTS RESERVED. NO PART OF THIS ELECTRONIC DOCUMENT CAN BE
ALTERED OR CHANGED TO CREATE AN ALTERNATIVE VERSION. NO PART OF THIS
BOOK MAY BE REPRODUCED OR UTILISED IN ANY FORM OR BY ANY MEANS DIGITAL,
MECHANICAL, INCLUDING PHOTOGRAPHY, PHOTOCOPYING, FILMING, RECORDING,
VIDEO RECORDING, ORBYANY INFORMATION STORAGE AND RETRIEVAL SYSTEM, OR
SHALL NOT, BY WAY OF TRADE OR OTHERWISE, BE LENT, RESOLD, OR OTHERWISE
CIRCULATED IN ANY FORM OF BINDING OR COVER OTHER THAN THAT IN WHICH
IT IS PUBLISHED WITHOUT PRIOR PERMISSION IN WRITING FROM THE PUBLISHER.
NO PART OF THIS PUBLICATION MAY BE REPRODUCED OR DISTRIBUTED FOR
COMMERCIAL PURPOSES.
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> ABOUT THIS MANUAL

The manual should be used as a reference guide. Additional tutorials and further tips will be
available elsewhere

NOTE: Plugins specific information can be found with the installation package of each plugin. However,
the parameters and features described in MXST chapter can be used as reference for plugin parameters

as well.

The manual is divided into five major parts:

General info about Maxwell Render.

Maxwell Render material system.

MXST: Maxwell Render Studio, a complete environment to import geometry, create and edit
materials and sending the full scene for rendering to MXCL.

MXCL: the rendering application.

Network rendering.

The following icons will appear on some pages to indicate an important point, or a tip:

This icon will tell you if there is something important to keep in %
mind to avoid common errors, unnecessarily long render times etc.

This icon will indicate useful additional information.

This icon will indicate an enhancement, new feature or function in Maxwell Render™ 1.5 ®©

This manual has been set in Futura BT and Arial type faces.
Manual Design by Solid Design and Next Limit.
Maxwell Render™ 1.5 User Manual is published exclusively by Solid Publishing.
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> MAXWELL SOFTWARE PACKAGE

Maxwell Render includes three different applications: the render engine (MXCL.EXE), the
standalone graphical application “Maxwell Studio” (MXST.EXE) and the standalone material editor
with browser (MXED.EXE) for the plug-ins. The software distribution also provides a set of plug-
ins for the supported 3D/CAD applications (available on the download page). There is specific
documentation included for every 3D plug-in available. The plug-ins take care of collecting the
scene information, applying Maxwell materials to objects and sending the full scene to Maxwell
for rendering.

> INSTALLATION AND LICENSING

INSTALLATION:
Windows:

Run the installation file (maxwell.exe) and follow the installation procedure. The Maxwell
executable files will be added to the system path. A user environment variable named
MAXWELL_ROOT pointing to the installation folder will be added. If this variable doesn’t exist
or is not created properly, the application will fail.

MacOSX:

Unstuff the installation package and drag & drop the contents into the Applications folder.
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Linux:
Installing tar.gz. Copy maxwell64-1.5.Linux64.tar.gz to /opt and uncompress and untar the package.
Type both gzip -d maxwell64-1.5.Linux64.tar.gz and tar xvf maxwell64-1.5.Linux64.tar

0

/]

Create a user environment variable named MAXWELL_ROOT that points to the Maxwell
installation folder. Depending on your shell, the procedure may differ slightly. For example, in
Bash shell use:

export MAXWELL ROOT="/opt/maxwell64”
export PATH="/opt/maxwell64/:SPATH”

\
—
-
-

In csh shell:
setenv MAXWELL ROOT ”/opt/maxwell64”
setenv PATH ”/opt/maxwell64:S$SPATH”
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PAGE IV

LICENSING:

In order to license copy and paste the license information placed at the end of the license email into
the license.txt file located in the Maxwell installation folder. If you purchased your license before
Maxwell Render 1.5's release, please note that your license file will also be recognized by Maxwell
Render 1.5 and you will not need a new license. If you buy new licenses or need to renew your
license, please make sure that you use the license.txt and remove older license.dat files. If you are
reinstalling Maxwell Render with the old license.dat file, please license the software by adding the
“license.dat” file sent by Next Limit to Maxwell using the menu option “Help >Register”. Alternatively
you can copy the “license.dat” file into the Maxwell installation folder.

BASIC USAGE

Maxwell Render contains three main executable files:

MXCL (Maxwell Render)
This is the standalone render engine. It can read and render MXS (Maxwell Scene) files.

MXST (Maxwell Studio)
A complete GUI application to create and render Maxwell scenes.

MXED (Maxwell Material Editor)
Standalone Material Editor with Material Browser for plug-ins. It is also used for creating material
libraries.

Maxwell Render provides two alternative workflows. One method allows you to use your existing
3D package and the provided Maxwell plug-in for it to send scene data to MXCL. The other
method allows you to import objects into MXST where you create/edit/assign materials, set up
lights and cameras and MXST then sends the scene to MXCL.

Below is a description of the basic steps involved in each method:

A) FROM THE 3D APPLICATION USING THE PLUG-INS

The plug-ins allow you to create/edit/apply materials to your object, adjust camera parameters,
sky/environment settings, and all other Maxwell relevant options. Initiating a render from your
3D application creates a Maxwell scene file (.mxs) which can either be rendered directly or
imported into MXST for further advanced editing. It is recommended to check the documentation
of the plug-ins for specific usage. Documentation for each of the plug-ins can be found with the
installation package of each plug-in.
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MXCL can also be called from the command line by providing a valid .mxs file. The most basic
(command line) method to use MXCL is by providing a .mxs scene in the form:

=T > i Scene

A path to the scene can be added:

By doing this, MXCL will start in no-GUI mode, so no render display is available. To be able to
visualize the render in progress, you must add the —d option to the command line:

This will start MXCL and also display its interface where the render in progress is shown and
numerous options are available which can be changed during and after the render has finished.
Another way to open MXCL with interface is to double click the MXCL shortcut in Windows.

For a description of all MXCL command line options available, please see page 111.

B) FROM MAXWELL STUDIO

MXST is an independent application which allows you to import objects in different formats, apply
materials, lights and textures, and render the scene.

This workflow is mostly recommended for people working with 3D applications that do not have an
available plug-in to directly connect their scenes to MXCL. But even if there is a plug-in available
for your application, MXST can still be used by importing your .mxs scene and making further
adjustments or even merging of different scenes using the various tools available in MXST.
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> WHAT IS MAXWELL RENDER

Maxwell Render™ represents the next generation in rendering technology. It is based on the
physical equations governing light transport and enables users to digitally create highly accurate
and believable imagery of the real world. Maxwell Render™ produces incredibly realistic illumination
without resorting to the tricks and approximations used by many current industry standard renderers.
Maxwell Render is more than just a render engine, it is The Light Simulator.

Maxwell Render’s algorithms and equations reproduce the behavior of light in a very accurate way.
All of the elements in Maxwell Render™, such as light emitters, material shaders and cameras
are entirely based on physically accurate models.

Maxwell Render's method of calculation always converges to the correct solution without
introducing artifacts due to the fact that it is an unbiased render. Unbiased means that no tricks or
interpolations are used to calculate the lighting solution in every pixel. It can fully capture all light
interactions between all elements in a scene. All lighting calculations are performed using spectral
information and high dynamic range data.

Maxwell Render™ operates as a stand-alone command line application that targets many different
environments of the high-end rendering market: architectural visualization, product design, jewelry,
film production, and scientific research. Maxwell Render™ has been built for Windows 32 and
64 bits, Linux 64 bits and MacOSX UB platforms. This version includes plug-in connections to
3ds Max, VIZ, XSI, Maya, LightWave, Rhinoceros, SolidWorks, Archicad, CINEMA 4D, form-Z,
SketchUp and indirectly AllPlan and solidThinking (not supported by Next Limit). Additionally, other
file formats are supported such as OBJ, STL, LWO, XC2, DXF, 3DS and FBX.

Maxwell Render™ includes features such as a material editor, material browser and library, texture
mapping support, light and camera editors and sky and environment options (all based in physically
accurate models). The 1.5 version provides both GUI and command line functionality.
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> MAXWELL RENDERT1.5 FEATURES

RENDER ENGINE CHARACTERISTICS
Physically Correct

Maxwell Rendering technology is strictly based upon the real governing physical equations of
light transport. Maxwell Render is capable of producing incredibly realistic illumination results
without having to resort to illumination tricks. Consequently the results produced by Maxwell
Render are highly accurate renditions of the real world.

Spectral Calculations for Light and Object Properties

Most render engines perform calculations in a specific colour space (typically RGB). However,
in harmony with reality, Maxwell Render considers light as an electromagnetic wave defined by
a frequency spectrum (ranging from the Infrared to the Ultraviolet). Once Maxwell Render has
completed the rendering procedure, each pixel in the output image contains different amounts of
spectral energy sourced from the light in the scene. Maxwell Render stores this information in a
proprietary format called MXI (high dynamic range format). The pixel colour which is generally the
final desired result is an interpretation and sensation of the different frequencies which arrive at
the film/sensor or the retina. Maxwell Render simulates this process and ultimately transforms the
spectral measures into known colour formats such as RGB.

Full Global lllumination

Maxwell Render calculates all possible interactions between light and the objects within a scene.
The global illumination interacts with surfaces and also layers beneath the surface to produce
translucency and subsurface scattering effects. Thanks to Full Global lllumination, any scene
containing complex caustics can be simulated in a realistic manner. These include reflection
and refraction caustics produced by indirect or direct lighting, caustics produced by dielectric
materials, plastics or glossy metals. No restrictions at all are imposed on the nature or the number
of caustics in a scene. Maxwell Render also computes full global illumination effects for moving
objects i.e. a moving glass object producing caustics will produce blurred caustics and even
volumetric blurred caustics if a participating medium exists.
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Unbiased Rendering

Maxwell Render is an unbiased render engine. Unbiased means that, with sufficient render time,
the rendered solution will always converge to the correct result without the introduction of artifacts.
Other render engines based upon widely known techniques such as photon mapping, radiosity,
light maps, irradiance maps or other interpolation methods always produce biased renders.
Consequently, they cannot guarantee convergence to the correct solution no matter how much
time is expended on the rendering process.

TECHNICAL CHARACTERISTICS

Multiprocessor

Maxwell Render can exploit all of the processors available on your system and can make
them work simultaneously on the same render to provide faster renders. For example, on a
multiprocessing platform with eight processors a user can expect up to an eightfold increase in
render performance/speed.

Multiplatform

Maxwell Render is a standalone application compatible with Windows 32 and 64 bits, Mac OSX
UB and Linux 64 bits.

Cross-platform

There are also a series of plug-ins connecting Maxwell Render to the most popular 3D applications
including 3dsMax, Maya, Cinema 4D, LightWave, XSI, Rhino, SolidWorks, SketchUp, Form-Z,
and ArchiCAD. However, an alternative workflow is possible using Maxwell Render Studio, a 3D
application to set up your scene. Most of the plug-ins have been rewritten or heavily improved
already (like 3dsMax, Maya, Rhino4, SolidWorks...) and we will continue doing so during the
upcoming months (XSI, LightWave).

Geometry Accepted

Maxwell Render is not a full 3D application but a render engine, so modeling within Maxwell
Render is not possible. Instead, Maxwell Render needs polygons to be able to light and shade
surfaces. So a lot of polygonal formats are accepted, like dxf, obj, and lwo among others.
Furthermore, plug-ins convert other types of geometry to polygons internally so that things like
nurbs and surfaces are still renderable.
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Preview Engine

Maxwell Render’s preview engine is called RSO0, as opposed to RS1, which is the render engine. This
preview engine is faster and lower in quality than RS1 and it has been improved for this version.

Core Engine

Key parts of the RS1 engine have been rewritten, resulting in many fantastic improvements,
bringing the quality of rendered images to a completely new level. Memory-intensive tasks such
as glare, Multilight™ with a lot of emitters, large geometries and a lot of heavy textures are easy
to handle for an average computer. The MXCL interface has been improved, adding some new
commands such as selecting render priority.

Command Line

Maxwell render has the possibility to make the render via console. This results in a faster render
as no application is launched and provides versatility as well. Following the tendency to improve
all areas, new commands have been created to have more control on the command line render

type.

Resume Render

As a consequence of the core enhancements, MXI files can always be resumed, allowing users
to refine the render even after it has been stopped, as many times as you want.

Log System

Improved log system with more information, warnings and error messages to keep track of your
renders. You can view full log in the console window of Maxwell Viewer.

Memory Handling

Memory handling has been greatly improved. This version uses much less memory than version
1.1, making it possible to render at very high resolutions (for example at 6000 x 6000 with less
than 2 GB of RAM) without losing quality because it uses about 3 times less memory. High-res
images are just a mouse-click away now.

File Management System

There have been several improvements in the way Maxwell Render manages external files
needed for the render, such as images, IOR files, r2 files, MXI, etc... Some of the improvements
include more options for default paths, automatic handling of missing paths and files, detecting
low size on disk to save MXS and MXI files, fixed issues with long paths, and more.
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Lights in Maxwell Render are defined by applying an emitter material to an object. This innovative
approach to simulate lights emulates what happens in the real world producing a higher degree of
realism in comparison to traditional render engines outputting smoother shadows and increasing
the overall quality. Another important characteristic of the Maxwell Render engine is the number
of lights that can be placed in the same scene. Most other render engines cannot handle a
large number of area lights without incurring a significant performance loss. Light sources in
Maxwell Render are defined by spectral characteristics. Thus a light source can possess a lot of
information about the intensity of emission at any of the possible wavelengths.

Using Maxwell Render, the user can choose from three different types of environments. The
first one is a sky dome, defined by color and intensity. Users can also choose for a HDR/MXI
environment to make use of lighting information of high dynamic range image formats. It is also
possible to use a physically-based sky simulator or physical sky, where the user simply specifies
the geographical location and the time of day for a scene and Maxwell Render automatically
handles the rest. Many improvements have been made in this area, including the ability to rotate
the north direction of the physical sky.

Multilight™ is an advanced tool for editing lighting. It allows changing the intensity of individual lights
during and after the rendering Qrocess. These changes affect all global illumination and lighting
aspects of the scene. Multilight™ is also a real compositor that can produce a lighting animation
from a single render. It is possible to save each emitter in a separate layers for each frame.

It also works with the latest enhancements in the MXI format, making the Multilight™ system
compatible with SimuLens™.
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SHADING
Materials Based On Real Optical Properties

Maxwell Render materials are defined in a physically correct manner from their BSDF curves
(Bidirectional Scattering Distribution Function) adding the ability to superpose different layers of
physical materials in the same object like other BSDF or SSS (Sub Surface Scattering) effects. Thin
coatings are also available for very subtle and realistic effects (for creating thin film interference
effects such as the multicoloured look of a thin layer of oil in water, or soap bubbles). The improved
calculation of IOR data provides the possibility for users to use IOR data files directly measured
in laboratories. This allows for easier rendering of real life materials.

Maxwell Render materials are not only physically correct but also very flexible and versatile.
They allow for the creation of special materials such as Opacity Maps and Clip Maps. Normal
mapping is also supported and now it is possible to set the intensity of Normal mapping with
bump value.

Emitter Materials are defined in a very intuitive way, using everyday terms like watts or
efficacy. Emitter materials can be mixed with BSDFs as well. In this way, if the light is “on” only
incandescence can be seen. But if the emitter is “switched off” the base material (metal, crystal...
any material) will be revealed.

The new Matte Material “flag” turns the assigned material into an invisible object, directly showing
the environment. This is very useful for compositing rendered images with photos.

Dispersion

Dispersion is a phenomenon that causes the separation of a wave into spectral components
with different wavelenghts, causing white light to separate into the colours of the rainbow. It
commonly happens when light goes through transparent materials. Dispersion is an important
touch for realism, especially when rendering things like jewels, or certain dielectrics, and it has
been improved in this version.

Material Library and Wizards

Among the possibilities to create and edit your own materials, Maxwell Render offers wizards
to quickly create materials. Maxwell Render materials can be stored in independent MXM files
(Maxwell Render material file), so you can make your own material libraries. To get you started,
Maxwell Render comes with a material library with more than 200 ready-to-use materials.

Also, the Maxwell Render material site (hitp://mxmgallery.maxwellrender.com) has been created
for users of Maxwell Render to share their materials with other users. The site has become a great
success in a short period of time — more than 1000 materials are freely downloadable!
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Material Editor has been rewritten from the scratch. Performance, usability and stability have
been further enhanced in all areas.

A small panel inside the material editor allows you to quickly see all the textures in
your scene, and drag & drop a texture from the panel into one of the texture slots.

The texture editor has been improved, giving you the option to view the loaded
texture at full resolution.

You can now copy textures and colours by dragging and dropping on other texture or
colour chips (even from different BSDF or coatings).

The new generation of plug-ins which started with the re-writing of the Maya plug-in is able to
interpret the 3D platform’s native shading to a greater or lesser extent.

Cameras in Maxwell Render operate completely differently to those in other render engines.
Traditionally, most render engines use a pinhole camera. This type of camera simulates a tiny
hole that allows light rays coming from the scene to reach the viewing surface. Maxwell Render
simulates a real camera with the associated lens set, diaphragm aperture, diaphragm blades etc.
By using this type of camera model Maxwell Render can automatically simulate depth of field,
motion blur effects, image distortion and aperture diffraction due to the lens set. Other render
engines currently on the market use post-render filters or special tricks to create these effects.

Maxwell Render does not produce motion blur as a post-process or using various tricks. Instead
Maxwell Render considers the moving objects to have random positions along their trajectories
during the camera shutter speed time. This creates a natural and realistic motion blur. Some
improvements in this area have been made for this version and now motion blur computes Clip
Maps and Opacity Maps perfectly.
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Simulens’

Diffraction happens when light goes through small holes (apertures) and behaves like waves. It ©
is very important in optics, as it explains why a perfect telescope (or microscope) that can take a
photo of a star and render it as a single dot instead of some circles (halos) or streaks. Maxwell
Render’s SimuLens™ system allows the user to define a pattern to simulate the shape of the
diaphragm that will model the pattern of light reaching the camera film, creating realistic lens
diffraction effects (glare). Furthermore, users can add a second pattern which defines “obstacles”

in the lens such as dust, fingerprints or eyelashes adding to a more realistic diffraction effect.

Diffraction

Happens when light goes through small holes (apertures) and behaves like waves. It is very
important in optics.

Lens Scattering

Is a new parameter part of SimuLens™, which simulates the scattering of light inside a lens system.
This effect is typically called “bloom” and users can control the amount of lens scattering.

These advanced controls brings a new level of quality and realism to computer graphics. Users
can now have control over Diffraction, the frequency of Diffraction, and also Lens Scattering
to simulate blooming effect. Also Vignetting control has been incorporated. Vignetting is the
darkening effect that happens on real world lenses, especially wide angle lenses. It's now possible
to remove this natural darkening partially or completely from your renders.

All these features are combined under Maxwell Render’s SimuLens™ system which is also
compatible with Multilight™.

NEW RENDER FEATURES
Z-Clip Planes

You can cut your rendered object with far and near planes and the render will show the interior ®
of the object, without the need to model the edges. Excluding desired objects from Zclip is also
possible.Very flexible and useful.

Shift Lens

This new camera parameter allows you to shift the film plane up/down and left/right, without
rotating the camera. This is very useful in architectural rendering for keeping a 2 point perspective
while capturing the entire building in the image.
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WORKFLOW

Maxwell Render provides two alternative workflows. One method allows the user to use their
existing 3D package and the appropriate Maxwell Render plug-in to send scene data to the
render engine (MXCL). The other method allows you to import objects into Maxwell Studio
(MXST) where you create/edit/assign materials, set up lights and cameras and MXST then sends
the scene to MXCL.

Maxwell Studio rewritten

Maxwell Studio has been rewritten from scratch. The performance, usability and stability have
been further enhanced in all areas.

Among a lot of improvements we highlight:
OpenGL® performance

The improvements in this area are huge. It is incredibly faster from previous versions
to load and edit geometry (and we really mean it). Thanks to this optimization, big
scenes with lots of textures are now easy to handle. Other special features have been
incorporated like the transparent shading of dielectrics in the viewports.

New Material Editor

The new material editor is integrated in Studio and the plug-ins, taking advantage of the
improvements.

Blow Up

This new feature allows the user to choose a region of the viewport and render it at the final
resolution chosen. It is ideal for rendering details without having to set a new camera.

UV mapping interaction

UV mapping interaction has been enhanced, avoiding disturbing wireframes over objects
when mapping.

New exporting options

Users have the option to export selected geometry like mxs or obj.

Exporting as mxs will also export the material(s) attached to the object(s).

Export to obj and mxs is protected by the user who created the MXS from the corresponding
plug-in by a tag in the plug-in interface.
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Maxwell Render Studio now keeps track of all scene changes and shows them listed in a
history panel. Users can scroll through the history list to undo/ redo changes. The history list
can also be purged.

Maxwell Render Studio’s user interface has been improved with an overall better organization.

now displays applied materials to the right of the object name, inside the
object list for a faster overview of applied materials.
has been fused with triangles and projectors panels. Parameters
panels have been redesigned for collapsing and expanding groups of settings individually.
and the possibility to change layout aspects have been added.
in object list and material list can be switched between small/medium/large.
textures can be dropped from one slot to another. Settings for one slot can be
quickly copied to all slots.
” list has been added to Physical Sky, which loads a list of cities from a text file.
Cities can be added/ removed easily from the list by editing the text file.
— when setting a certain location, Studio automatically sets the correct
GMT for that location.
the Physical Sky system for easier positioning of the sun. Ability to rotate
and scale the entire scene, along with the cameras.
and searching for missing textures greatly improved.
or cameras to prevent accidental movement

This new generation of plug-ins is highly superior to previous ones, and we will continue
to improve all plug-ins. Generally, the plug-ins are much more integrated and transparent
to users, allowing for a faster workflow, more flexibility and ease of use.

This version includes plug-in connections to 3ds Max, VIZ, LightWave, Maya, Rhinoceros,
SolidWorks, Archicad, CINEMA 4D, form-Z, SketchUp.
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OUTPUT
MXI

MXI is the Maxwell Render proprietary high dynamic range format. It stores lighting information
per pixel and per light individually (if Multilight™ is enabled) along with RGBA values, as opposed
to common 24 or 32 bits images that can only store RGB or RGBA values.The MXI format is more
powerful now. It allows users to Resume and it is compatible with SimuLens™ and Multilight™. Its
size is around 3.5 times smaller than in previous versions, indirectly enhancing other features like
Networking.

Other formats

Of course, Maxwell Render can export to most common formats like JPG, PNG, TGA ... and now
also in 32 bits and HDR as well.

Supported texture formats

These have been greatly expanded to allow many different image formats to be used as textures.
The following table describes which formats are supported:

Bits Per Channel

8-bit 16-bit 32-bit 1-bit Alpha Trans  Interlace | RLE
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Render Channles
Maxwell Render can export different layers for compositing purposes:

Render
Alpha
Shadow
Material ID
Obiject ID
ZBuffer

Among the enhancements in this area we can highlight the new Shadow Layer, which simulates ©
the cast shadows of the materials with the “Shadow” Flag enabled.

NETWORK RENDERING

The Maxwell Render Network system allows jobs to be sent individually to each machine on the ©
net, rendering animations and frames. It is even possible to let all machines render the same
frame individually and merge the images that have been created at the end of the rendering
process. It has some further useful functions like grouping nodes for exclusive assignment or
displaying jobs.

Maxwell Render’s networking has been vastly improved and optimized, making it more stable
and faster.

We can highlight the following improvements:

It is possible to set the networks components like servers or managers and to display them more
quickly by clicking on the new icons from the Maxwell Render root program.

Job queue now includes more information to track your renders, so that you know exactly at
which point a job is. This includes SL, more status info, rendering time, next update, target SL,
and others.

Displaying jobs

One of the most powerful feature of the Job Queue window is the Display function. While
servers are rendering you can select any of them and when you press the Display button it
will automatically reveal the image being rendered on that node. Display button also supports
instantaneous viewing of a cooperative job as merged during the render progress.

Redesigned Ul

Maxwell Render engine (MXCL) interface has been redesigned so that Network rendering is more
comfortable to the user.

NN
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Selection of servers

Selection of servers has also been improved, and it is now possible to select machines by name
or IP.

MXI merging improved

MXI merging has been improved when it is saved and loaded again, making it more stable.

SDK

Maxwell Render Standard Development Kit is available upon request and proposal evaluation.
Some improvements have been made for third party developers.

We can highlight the following improvements:
MXS file creation is faster and safer.
Support for new features.

New platforms supported.
Available for OS X, Win 32 and 64 bits and Linux 64 bits.

If you are a developer and are interested in Maxwell Render’s SDK, please send us an email
explaining your interest to http://www.nextlimit.com/sales _support.htm.

COMMUNITY

Smart community

Maxwell Render offers a variety of learning resources like manuals, tutorials, videos, forums
and a very open and friendly community. Maxwell Render users are enthusiastic people and we
like to call them “the smart community” because they share, talk and learn from each other with
respect and passion. Lead by the A-Team (Maxwell Render experts and testers), you can also
become part of this adventure.

Learning curve

Maxwell Render is very easy to learn but it is also flexible enough to allow for in-depth technical
tests, reviews or renders if that is what you are looking for.
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> MATERIALS: INTRODUCTION

Before explaining the material parameters used in the Maxwell material system, it is important

to have a basic understanding of what light is, how it interacts with materials and why a material R

looks shiny, dull, transparent etc. Please review this information as it will make the parameters in White |IQ|‘IT/
the Maxwell material editor much easier to understand.

' ﬁ’ ?Reflected red light

WHAT IS LIGHT?

Visible light is really a very small portion in a range of electromagnetic radiation. This radiation
travels in waves of different wavelengths. The difference in wavelengths (the “tops” of each wave)
is what makes the difference between blue, red, gamma rays, x-rays, radio waves etc.

L
-

Infrared Radar FM| TV |Shortwave| AM
rays

Gamma
rays

Visible light

400nm 500nm G00nm 700nm

Wavelength (nanometers)

“White light” is a combination of all the colours in the visible light spectrum and when we perceive
an object as red for example, what happens white light falls on the red surface, and all the
wavelengths except those that give red light, are absorbed by the material. Only the red portion
of the spectrum is reflected back.
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DIFFUSE-SPECULAR & REFLECTED LIGHT

We see an object because light is reflected from its surface into our eyes. That is, ALL light is
reflected light. This may sound confusing at first because it has become common in renderers to
refer to reflected light as specular (or sharply) reflected light.

In the real world light doesn’t have a separate “diffuse” or “specular” part. So what makes a
surface look dull, or mirror like? It is the smoothness of its surface.

A surface which is not very smooth has tiny imperfections which scatter the light in all directions,
thus creating a very “diffuse” reflection of its environment:

A surface which scatters almost all light in a chaotic, diffuse way is called a lambertian surface,
such as the red ball in the above image.

A smooth surface however reflects light uniformly and creates a very sharp, or specular reflection
of its environment:

It is important to note that because very smooth surfaces perfectly reflect, they reflect much less
of their own colour. This is visible in the in the render on the left, where the ball is still tinted red,
but since it is virtually a tinted mirror, its own colour shows much less. There are a few exceptions
however and one of them is metals. Even if they are very smooth they reflect their own colour
much more. The environment they reflect will become much more tinted by their own colour.
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TRANSPARENCY

An object becomes transparent when light doesn’t stop at the surface, but goes through the object
and out the other side. When light passes through a material, it slows down because the material
is denser than vacuum. Because of this change in speed, the light is bent, or refracted when going
from vacuum (or air) into the material. This refraction occurs whenever light changes speed, so
it happens when it moves from one material to another with different densities. The refraction is
also what causes “caustics”, concentrated pools of light.

In the render on the right, it is refraction that makes the checkered pattern look distorted, and
makes the caustics pattern. Different materials slow down light more, or less, relative to the speed
of light in air or vacuum. This difference between lightspeed in vacuum <—> lightspeed in medium,
is specified as the index of refraction (IOR) for that particular medium.

THE FRESNEL EFFECT

The Fresnel effect is the apparent increase/decrease of a surfaces reflectance based on viewing
angle. For example if you look at your monitor screen straight on, the monitor glass shows almost
no reflection, but if you look at it from an angle almost parallel to the glass, it has become very
reflective. The Fresnel effect is dependant on the IOR of the material. The higher the IOR, the
more reflective the material becomes at ALL angles, so the fresnel effect diminishes — the material
becomes equally reflective at all angles.
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FILE MENU

MATERIALS PROPERTIES PANEL Q

TEXTURE BIN

COLOUR CHIP

ON/OFF CHECK BOX TEXTURE ICON

() ADDITIONAL BUTTONS

MATERIAL COMPONENT WINDOW O SURFACE PROPERTIES PANEL TEXTURE BIN O
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> MATERIAL EDITOR

The material editor is one of the most important areas of Maxwell. It provides a powerful set of
parameters for advanced editing of a Maxwell material. The four main areas of the material editor are:

MATERIAL EDITOR

A) Material Components

Maxwell's materials can be composed of different layers and each layer includes one BSDF,
a coating and a Subsurface Scattering (SSS) component. Emitters are also defined here.

B) Material Preview
Provides a quick preview of the material. Preview options are accessible via rightclick.

C) Material Properties
Parameters to control the main optical properties for each material component
(BSDF, coatings, etc).

D) Surface Properties

Parameters to control surface properties of a material.

The material components area also contains six buttons to control various aspects of the material and material editor:

NORMAL / ADDITIVE BLENDING MODE

DISPERSION ON/OFF

REFRESH MATERIAL PREVIEW
MATTE ON/OFF

SET ACTIVE VIEWPORT TEXTURE

SHADOW ON/OFF
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FILE MENU

-

New Mxm

Open material
Export material

Extract materials from scene

BASICS MENU

-

BSDF  (Bidirectional Scattering Distribution  Function)
mathematical function that describes how light is scattered by a
surface. The BSDF basically represents the optical properties of the
main volume of the object, whether diffuse, metallic, dielectric...
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FILE MENU

The File menu in the material editor has the following options:

New MXM:

Creates a new material

Open material

Lets you load a .mxm file (Maxwell material file). The material will be loaded into the material
editor as well as added to the scene material list (if Studio is used).

Export material
Lets you export the currently loaded material as a .mxm file (Maxwell material file).

Extract materials from scene
Lets you choose a .MXS file and extract all the materials in that scene to a folder of your choice.

BASICS MENU

This is a helper for creating materials, similar to the Maxwell beta style material creation. You can
create 5 types of basic materials: Diffuse, Emitter, Metal, Dielectric, Plastic. Note: You must first
create a new material using File>New mxm for the material to be added to the material list, then
you can use the Basics button to adjust the material.
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WIZARDS MENU

This feature is a step by step guide to creating several types of common materials such as Wood,
Concrete, Bricks, Clipmap etc... The Wizards will ask you for textures, bumps, reflectance maps
and material values such as roughness and colour.

Note: You must first create a new material using “File > New mxm” for the material to be added to the material list,
then you can use the Wizards button to adjust the material.
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WIZARDS MENU

-

ACS

Brick

Bubble

Car Paint

Clip Map
Concrete

Glass (High Grade)
Glass (Low Grade)
Greasy

Opacity Map
Plastic

Satin

Towel

Water

Wood

Wooden Floor
Velvet
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MATERIAL LAYERS

Keep in mind that a BSDF can be any kind of material (dielectric,
diffuse, metal...) and that coatings are always transparent as they are
very thin. Also any of these layers can not only be a BSDF, but only a
coating or SSS component for example. Very complex materials can
easily be created this way.

ADDING/REMOVING LAYERS

-

Add Basic Layer
Add Emitter

Add Coating
Add SubSurface
Embed MXM
Reset Layer

Remove Layer
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MATERIAL LAYERS

Maxwell materials can contain several layers, and each layer can include one BSDF component,
one coating component and one SSS component:

MAXWELL MATERIAL
Basic Layer 1
Coating
BSDF
SSS

BASIC LAYER 2
Coating
BSDF

Layers can be controlled through a general strength factor or a weight map, and can be set in a
normal or additive mixing mode. More detailed info about these concepts in the following pages.

ADDING/REMOVING LAYERS:

In the material component panel, Rightclick in the panel. The following menu appears:

Add Basic Layer

This option creates a new layer with one BSDF. Only one BSDF is allowed per layer.

Add Emitter

Adds an emitter component. Emitters can be mixed with a material, for example if you have this
material applied to a lightbulb, when the emitter is on, it will shine light on the scene just like
a regular emitter, and when turned off, it will reveal the glass bulb material. Only one emitter
component is allowed for the whole material.

Add Coating

Adds a new coating to the selected layer.

Add Subsurface

Adds subsurface component to the selected layer (only one SSS component per
layer is allowed)
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Embed MXM file

Imports an MXM (Maxwell material file) into the current material. The new materials layers are
added to the current layers.

Reset Layer
Restores default parameters in currently selected layer.

Remove Layer
Deletes the current selected layer. You can click on the folder icon to delete all the components in
the layer, or click an individual component to only delete the selected component.

Example of mxi emitter added to a material.

Material + Emitter layer and glass emitting light.

For example if you have this material applied to a lightbulb, when
the emitter is on, it will shine light on the scene just like a regular
emitter, and when turned off, it will reveal the glass bulb material.
Only one emitter component is allowed for the whole material.
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LAYER WEIGHTING

-

\,

bl
# BSDF

s Basic

. Coating
# BSDF
Pm Basic
# BSDF

y

A complex material made from several basic layers blended together.
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LAYER WEIGHTING

As mentioned earlier, the influence of each layer can be controlled with a weighting factor, or a
black and white texture (white means more influence). To change the weighting or add a texture

to the weighting, click on the folder icon of the layer, and in the main area, adjust the weighting
or load a texture.

The weight value controls the way different layers are blended together. For example, if there are
two layers, setting 50 for both layers will produce a 50% contribution of each layer. Using a texture
can produce more sophisticated blending between layers.

Layer weighting is always normalized internally by Maxwell, meaning if you have 3 layers, weighted at 40, 50,
70 respectively, their added contribution will not exceed 100. Their real contribution will then be 25 / 31 / 44
(40+50+70=160: 40/160=25, 50/160=31, 70/160=44). This means you don’t have to worry that the

total weighting of all layers will exceed 100 and produce unnatural results.

The current weighting of the layer is displayed to the right of the layer folder. If a texture is used
to weight the layer, a “T” will appear instead of a number.

The order of the basic layers does not interfere with the material behavior. The contribution of
each basic layer is only determined by its weight and the blending mode enabled (Normal or
Additive — more about this on the following page).
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BLENDING MODES:

Each Maxwell material can be blended in one of two modes: Normal or Additive. It is important to
understand that this blending mode applies to the whole material, not to individual layers.

Change blending mode by clicking on the Blending mode button.

Normal mode
Should be used when making materials that are “fused” together, such as a mix of metals, or
different coloured glass.

Additive mode

Should be used when making materials that are mixed one on top of the other, such as rough
molded plastic with a clear smooth coating applied on top, ceramics with smooth coating, laquered
wood etc...

MATTE MATERIAL

This option turns the material into a matte material which “cuts” through the entire image and
reveals the background (for example physical sky if it's enabled, or black if no environment
lighting is used). This is useful for compositing purposes, for example if you have columns in front
of a character, and the columns will be rendered in another pass, you can turn on Matte material
for the columns, and the character will be rendered with the columns “cut” from the character. The
columns will still contribute to the lighting, even with matte material turned on.

The scene contains a backdrop which has matte material turned on in its material. The resulting
render shows the black background, while the backdrop still influences the scene lighing.
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BLENDING MODES

The Normal / Additive blending mode button. -

The difference betweem Normal & Additive blending mode.

Example of using Normal (N) Vs Additive (A) blending modes. In
this example a clear coated plastic was the desired material, so
Additive mode is clearly more suitable.

MATTE MATERIAL

The Matte Material ON/OFF button. —
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SHADOW CHANNEL

SHADOW CHANNEL Turning on this option for a material will make all objects with this material applied behave as
shadow catchers. If you turn on shadow channel in the Render Options panel, all materials that
have this option turned on will render shadows only. All materials with this option off will render
white. This allows you to render out a shadow only pass for compositing purposes. The following
image demonstrates the procedure:

—
The Shadow Channel ON/OFF bution. Photograph taken to serve as background.

Render of a scene.

Alpha channel rendered to crop out the background.

Objects cropped in Photoshop using the alpha channel.

The rendered shadow pass.

The shadow pass composited in Photoshop using “Multiply” as the blending mode.
Additionally, the shadows can be tinted using a Hue/Saturation adjustment layer in
Photoshop.

Objects pasted into photograph background.

Final composition.

SHADOW CHANNEL

oAM=

o~

\,
The Rendered Shadow Channel.
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MATERIAL PREVIEW

This panel shows a preview of the current material. To preview a material, click the icon, or
double-click on the preview image, or use the ‘CTRL+P’ shortcut. Rightclicking on the material
preview, you can access some specific options:

Load scene to preview

The preview window can preview any MXS file. By default it uses the defaultpreview.MXS file in
the preview folder (Nextlimit/Maxwell/preview).

PREVIEW OPTIONS:

This option specifies the quality and number of bounces of the preview engine. Complex materials
may require higher quality settings. These options are also available in the Preferences panel.
There are two render engines you can use, the engine ment for preview renders, named RS0
(which is selected by default), and RS1, the same render engine used in the final render.

Making your own preview scenes

The material preview window can actually render any MXS, this is useful to preview specific
scenes or objects. When the Rightclick menu is shown, all the MXS files available in the preview
folder are shown, letting you choose the desired one.

You can simply make your MXS scene as usual and make sure you have a material called
“preview” in the scene applied to the object(s) you want to use for material previewing. Then save
your MXS in the preview folder located in the Maxwell install folder.
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MATERIAL PREVIEW

Load Preview Scene
Preview Options

arroway
defaultpreview

drapery_bpd
gem
jewels_sam7
preview_jose
stagel_tom
v stage2_tom

Rightclick on the preview window for Preview Options

PREVIEW OPTIONS

Preview Options Panel
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TEXTURE PANEL
p

Texture picker dialogue window.

A\

If an object only has one UV set, but you specify in the texture
picker for the texture to use UV set 1, you will get an error at
rendertime, specifying the object does not have enough UVs to
render the texture. Make sure you use UV set O for all objects that
only have one UV set applied to them.

/Applications/Maxwell/materia...es/arroway/boards+02_d100.Jp¢

\,

Textures are available for selecting in the drop down menu. I
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TEXTURE PICKER

Clicking on any texture icon [Bg will bring up the texture picker allowing you to load a texture.

Loading textures

To choose a bitmap, click on the Load Button or drag and drop it from any Explorer or desk top
window into the main frame. You can drag and drop multiple textures at once. This will make the
textures available for selecting in the drop down menu.

Unloading a texture

Select a previously loaded texture from the drop down menu and click Unload button to remove it
from the scene. This will free up some memory used by Studio.

Tiling Options

Choose to tile the material in X,Y axis and the tiling amount.

Offset texture
Choose an offset for the X,Y axis.

Invert texture

Inverts the loaded texture. Practical for black and white textures used as weightmap on a 2 bsdf
material. You can re-use the inverted version of the same texture on the second bsdf weight.

Real scale (m)

Checking this box will make Studio use a 1m x 1m x 1m projector for this texture, regardless of
what other projector is applied to the object. This is very useful for creating reusable materials
which you can simply drag and drop on any size object. For example if you want to create a
material with 25cm tiles, check the Real Scale Box, and set the tiling for both X and Y axis to 0.25.
Now you can drop this material on any size floor and your tiles will always be 25cm.

Channel

Specify the UV set to be used for this texture. In Studio a “UV set” is a set of UV coordinates for
an object. One object can have several UV sets. If an object only has one UV set applied to it, that
UV set will be nr 0. If an object has 2 UV sets, they will have the numbers 0 and 1. More info on
texturing workflow in Studio can be found in the TEXTURING section on page 91.
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COLOUR PICKER

Maxwell colour picker is a simple and fast tool for choosing colours. The circle on the outside
coloured wheel lets the user rotate the triangle inside, choosing the hue. The second circle lets
you choose value and brightness within the hue selected. You can also specify the colour in HSV,
RGB or XYZ coordinates with the text boxes below the chromatic graph.

DRAG AND DROP FUNCTIONALITY

The material editor has certain drag & drop features. You can drag & drop:

COLOUR CHIPS
TEXTURE ICONS

By default both texture and texture settings (tiling, offset etc) are copied. Hold Shift before
starting the drag & drop to only copy the texture itself.

The drag & drop functionality also works between BSDFs — you can drag a colour chip or texture
icon, from one BSDF to another. To do so, start dragging the icon over a BSDF layer icon, and the
rightside of the material editor will change to show the BSDF layer properties. Now you can drop
the icon in one of the appropriate slots.
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COLOUR PICKER
p

N
\

DRAG AND DROP
s N
\

You can drag and drop colour chips and texture icons into other areas.
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> MATE RlAI—S COMPON E NTS DIFFERENT FRESNEL COLOURS

BSDF PROPERTIES ( )

The BSDF component is the base of the Maxwell material system. It contains all the parameters
necessary to create many different types of materials ranging from clear glass, sandblasted glass,
plastics and metals. In this first section we will go through each parameter in order, with a brief
description of each. In the second section we will show different material examples and discuss
the settings used.

When a BSDF is selected in the material layers, the BSDF properties are displayed in the right
panel. There are two sets of controls: Material properties and Surface properties.

MATERIAL PROPERTIES:
Reflectance 0° / 90°

This is the light reflected by the material. In other words: it is the material’s colour. Choose a
reflectance colour by clicking the colour picker, or specify a texture by clicking in the texture
button g™. You can enable or disable the texture using the check button near the texture button.

Afull white reflectance (RGB 255) means that all the light that falls on the object is reflected back.
Black reflectance (RGB 0) means that all the light is absorbed.

There are two reflectance colours depending on the light reflected when the object is seen at 0°
degrees (frontal view) or at 90° degrees (glancing angle).

The Reflectance 0° is the objects main colour. The Reflectance 90° colour is the objects colour at
glancing angles. This is useful when you have a material which reflects one colour when viewed
straight on, but at sharper viewing angles reflects another colour, such as tafta, silk, velvet etc...
Think of the Reflectance 90° colour as the object’s “specular” reflection.

How much influence the reflectance 0° colour Vs the reflectance 90° colour has on the look of the
material depends on the Nd setting of the BSDF, and the roughness setting. More on these two
parameters in the following pages.
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Avoid setting the Reflectance 0° colour very high, especially RGB 255,
since that would mean all the light that falls on an object is reflected
back. Such a material does not exists: some energy absorption
always occurs. Maxwell internally obeys energy conservation laws,
even with Reflectance 0° at 255, but setting Reflectance 0° to almost
pure white will cause loss of contrast and much more noise in the
renders. A white piece of paper in reality has the reflective RGB
equivalent of about 220. Reflectance 90° colour however can be
set as high as 255 if you need strong reflections.

\, y

Thicker areas are more attenuated.
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For most materials, reflectance 90° colour is white, however materials like metals usually have
tinted reflections. Changing the reflectance 90° colour allows different reflected colours at the
edges of the object like in the samples below. Different combinations of reflectance 0° and 90°
are shown in the next figure:

Transmittance

For transparent materials, this parameter controls the colour of the light which passes through an
object. Choose a transmittance colour by clicking the colour picker, or specify a texture by clicking
in the texture button ®®. The transmittance colour represents the colour of the light when it has
reached the attenuation distance.
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Attenuation distance

As light travels through a material, it loses energy and the attenuation distance parameter allows
you to specify how far light can move through the object before losing half its energy. For example
if you have a 2cm thick glass window and you set the attenuation distance to 2cm, then light
shining through the glass on the other side will be half as bright.

Attenuation distance and transmittance work together. You must set transmittance higher than
RGB 0 for the attenuation distance to be taken into account. Also, if your attenuation distance is
very small (1nm), the object will remain opaque, since light can only travel a very small distance
into the object. On the other hand, if you have a 1cm thick glass window and set attenuation
distance very high (ex. 900m), and set transmittance colour to blue, the glass will not be coloured
blue at all, it will be completely transparent because there was not enough distance in the 1cm
thick glass to cause any attenuation and therefore reveal the transmittance colour.

The attenuation is ruled by an exponential curve, therefore, the thicker the object, the more
attenuated the light will be, as in the example on the right.

To better understand the concept of attenuation, consider sea water. When the water layer is very
thin (like water in the palm of your hand) you don’t see attenuation and get rather transparent
water, when you have enough water thickness, you see a typical sea colour (dark or light blue-
green, depending on deep or shallow waters). The transmittance colour represents the colour that
you want to get approximately at the attenuation distance. Beyond this distance, the light is more
and more attenuated, it loses more and more energy and the view eventually turns black.
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ATTENUATION DISTANCE

Blue transmittance colour/Attenuation distance (18cm) /
No roughness (1)

Blue transmittance colour/Attenuation distance (18cm) /
Medium roughness (40)

Transmittance map/Attenuation distance (18cm) /
Medium roughness (40)
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CUSTOM Nd

The Nd and Abbe input filed can be found in the Material Editor
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Custom Nd

Simply put Nd, should be regarded as the IOR (index of refraction) of the material. The name Nd
is used because it is the common way to denote an index of refraction that has been measured
at the wavelength of 583nm.

Before explaining further how Nd influences the look of a material, it is important to understand the
“Fresnel effect”. This effect states that the strength of reflections on a surface is dependant on the
viewing angle. For example if you look straight on at your monitor screen, you will see very weak
reflections, however if you look at the screen at an angle, the reflections will appear stronger.

The relationship between Nd and the fresnel effect is that with a higher Nd number, the surface
will start to look equally reflective, no matter the viewing angle. So in effect, higher Nd “cancels”
the Fresnel effect.

With this in mind, understand that changing the Nd number controls the overall reflectivity of
an object. For example you can have the reflectance 90° colour set to full white, but with an Nd
of 1, the object will not seem reflective. Setting the Nd to a high value like 40, and keeping the
reflectance 90° to that same full white colour, will result in a mirror like surface. The following
images demonstrate this:

From the images above you can see that raising the Nd has the result of increasing the influence
of the reflectance 90° colour, while the reflectance 0° colour (in this case it was set to almost
black), has less and less influence when increasing the Nd.

Of course the value of the Reflectance 90° colour will also affect the maximum strength of
reflectance. For example you can set a high Nd but set the reflection 90° colour to a dark colour.
The result will be a surface which is reflecting equally, no matter the viewing angle, but the
reflections will appear weaker.

For opaque materials, an Nd of at least 3 is recommended if you want them to become reflective.
Metals have even higher Nd. The Nd setting can go as high as 1000. For a mirror like surface it's
usually enough to set the Nd at 100.

Note: For a lambertian material, the Nd has no influence on the look of the material.

For transparent materials, Nd also controls the amount of refraction. Seawater for example has
an Nd of about 1.33.
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Abbe

Different wavelengths of light can be refracted at slightly different angles as they pass through a
material, and this is what causes dispersion, the effect seen when a beam of light passes through
a prism and is split up into the different wavelengths of light. The name Abbe comes from the
German physicist Ernst Abbe, who defined the Abbe number.

Abbe controls the amount of dispersion, the higher the Abbe number, the narrower the meaning
the dispersion effect will disappear the higher you set the ABBE number.

Load file

This option allows us to include an .r2 file to have a maximum control of the fresnel effect over the
surface. r2 files will be explained in more detail in a later section of the material editor.

Load full IOR data

As an alternative to the Reflectance, Nd and Abbe values, you can use an .ior file which provides
Maxwell with the exact index or refraction for each wavelength.

“Complex IOR” (a.k.a. Full IOR) data is collected from precise measurements in laboratories and
describe the optical properties of a material to the highest degree of accuracy. These materials
have the advantage of being extremely realistic, with two drawbacks:

The use of complex IOR data means Maxwell has a lot more math to do. Complex IOR
computations require evaluation of more mathematical functions and they are dependent on view
angle and on spectral wavelength as well as involving the computation of full dispersion (which
by itself introduces a performance hit; taking longer to resolve image noise). This method does
not allow many optimizations without sacrificing the intended physical accuracy. Metal ior files
however can still render.

Unable to customize the material properties in the complex IOR database and cannot change
parameters to derive new custom materials. However surface properties such as roughness,
anisotropy, bump can still be changed when using ior files. Of course a BSDF with an IOR file
loaded can still be mixed with other “regular” BSDFs to create many interesting materials.
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Dispersion will raise the render time; therefore it is disabled by

default. In order to enable dispersion, click on this button [

Spectral dispersion
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THE COLOUR CHIPS:
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In the above image the following angle map was used for the top
of the cylinder (no map was used for the sides of the cylinder):
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The Colour Chips

Reflectance and transmittance influence each other. For example if more light is reflected from
the surface of the object, then less light will be transmitted through it. Therefore, the reflectance
and transmittance colours are corrected according to this. You can see a second colour square
showing the corrected colour. Hovering the mouse over the squares will show a tooltip with the
numerical RGB values.

SURFACE PROPERTIES:

Roughness

The roughness of the surface ranges from 0 (perfectly smooth surface) to 99 (almost pure diffuse).
The Lambertian checkbox will use a perfect diffuse model (like 100% roughness). It is important to
remember that if you want to have very smooth, mirror like surfaces, or clear glass, the roughness
should be low (ex. 0-10). If you have a higher roughness than that, the glass or mirror surface
will start to appear as the image on the left demonstrates influence of the roughness parameter
on a glass material:

You can also set a black and white texture to control the roughness. Brighter values in the texture
means higher roughness (a more diffuse surface). When using a texture the roughness number
is still applicable, but with a texture applied, it controls the maximum allowed roughness. For
example, if you use a black and white checkermap as a roughness texture, and you set the
roughness to 30, then the white parts of the texture will result in 30 roughness, while the black
parts will represent 0 roughness. If you now change the roughness to 70, the white parts of the
texture will result in 70 roughness and the black areas will still represent 0 roughness.

Anisotropy

Specify anisotropy strength (0 for isotropic surfaces — 100 for full anisotropy). You can also set a
texture to control the anisotropy strength.

Angle

Specify the anisotropy angle (the main direction of reflected light). You can also set a texture to
control the anisotropy angle.

Bump

Specify a bump texture and the bump strength. There is an additional option to specify a normal map
as a bump texture. For normal maps, you have the choice of flipping the X,Y,Z in the texture picker,
depending on how the normal map was created. Bump is a very sensible parameter and standard
values will go around 20. Bump strength number has no influence when using a normal map.
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COATING PROPERTIES

Coatings are very thin layers that are placed “on top” of the BSDF. Because coatings are so thin,
they produce an effect called “thin film interference”, which breaks up the light and can cause a
rainbow like pattern. Think for example about spilling a drop of oil on a surface of water, the very
thin layer of oil will create interference patterns. The coatings can also be used to create rough
materials with a clear coating, for example, a glossy white plastic can be made of a diffuse BSDF
plus a coating.

The main property of the coating is its thickness. The thickness is specified in nanometers (nm).
The thickness can be specified by a numerical value or through a weight map. To avoid interference
colouring, you have to use higher thickness values such as 1 mm (1000000 nm).

Only one coating is allowed per BSDF. You can make a material having just a coating and no
BSDF. To do this, add the coating normally (Rightclick on the BSDF or the BSDF Folder > Add
Coating), and then simply select the BSDF and delete it by pressing the Del key on your keyboard
or right-clicking and choosing Remove Layer.

Coatings with different thickness.
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COMPLEX IOR FILES

4 N

Water bubble using the h2Q.ior file Coating bubble and coating
applied to diffuse sphere.

PAGE 47



SCATTERING

'd )

For the above images, transmittance was set at RGB: 200,100,100,
orin HSV: 0, 150, 200. The left image has the default SSS settings
of absorption 0.5 and scatter 0.5. The right image has absorption
set to 30.

Increasing the transmittance and keeping the absorption high
can create materials that make the SSS effect more sensitive to
thickness variation in the model. For example:

Both images have absorption set to 30. Left image has a
transmittance value (HSV) of 200, right image has a value of 250.
You can see the subscattering seems to be more “localized” in
the right image, we get a bigger distinction between areas that
show subscattering and areas that do not. For instance, the thinner
ring lets the subscattering peak through, and the scattering is also
brighter on the upper left part of the sphere because that is the
direction the light is coming from.
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SUBSURFACE SCATTERING PROPERTIES

Subsurface scattering (SSS) properties can be added to each BSDF. Transmittance must be set
to any value other than black for SSS to have an influence on the material. Higher transmittance
values will result in brighter and more transparent subsurface effect. When adding an SSS
component to the BSDF, the attenuation distance of the BSDF is not taken into account, and it is
the absorption unit of the SSS component that will control the amount of absorption/attenuation of
light inside the material. An Nd of about 2-3 should be used for subscattering effects. Lower Nd
can be used if a very clear material is desired.

Absorption
Defines the amount of light to be absorbed through the object surface. When raised, the surface
will absorb light quicker.

Scattering
Defines the amount of light to be scattered through the surface. When increased, it has the
effect of increasing the spreading of light in the surface.

BOTH IMAGES HAVE AN ABSORPTION RATE SET TO 0.1.

THE LEFT IMAGE HAS A SCATTERING SETTING OF 0.1. THE RIGHT IMAGE HAS SCATTERING SET TO 0.5.
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The effect of different scattering settings can be difficult to see, it depends largely on the size of
the object. In small objects even a low scattering value will have the effect of scattering much of
the light.

Subsurface scattering effects

EMITTER PROPERTIES

The emitter material can be applied to a BSDF material, or it can be a material of its own. Emitter
materials can be applied to any object in Maxwell. To create an emitter-only material, create an
emitter type material. To add an emitter component to a normal material, right-click on any of the
BSDFs or BSDF folders and choose Add Emitter. Only one emitter component can be added to
a material.

Input
This is the most important parameter as it defines which type of emission will be used emission.
There are several possibilities:

Color + luminance
Temperature of emission
MXI texture

Load emission data file
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EMITTER PROPERTIES

-

Emitter
Light properties

Inpuk Color + Lurninance

[ v RGE -

Emitter properties. Input: Colour +Luminance

In most situations, an emitter material should be applied to a
single polygon plane. Try to keep the geometry of the emitter as
low as possible as it takes more time to remove noise if the emitter
is made of complex geometry.

EMITTER PROPERTIES

Vs

\,

Emitter properties. Input: Temperature of emission
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TEMPERATURE OF EMISSION
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Emitters at different °K temperatures

MXI TEXTURE

-
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COLOUR AND LUMINANCE:

Colour

This parameter refers to the colour of the light emitted. There are two ways in which you can
specify the colour.

RGB

(Red, Green and Blue). Clicking on the coloured square allows the user to choose a colour in the
Maxwell colour picker.

Correlated colour at

Lets you choose the colour that would correspond to an emission in Kelvin degrees. Please note that
choosing this option will not make any changes on intensity, just colour. Low Kelvin temperatures
are reddish coloured, 6500K is considered white, higher values will produce bluish light.

Luminance
Specifies the intensity of the light. There are several ways the user can choose.

Watts and Efficacy

Allows you to specify how much electricity a lightsource consumes (Watts) and how efficiently
it converts that electricity into visible light (Efficacy). The efficacy number specifies how many
lumens are emitter per watt. For example a common 40W incandescent bulb will have a pretty
low efficacy of 12.6 lumens/watt. This data can usually be found on the manufacturers website.
However a more efficient energy saving bulb which is also rated at 40W will have an efficacy of
perhaps 17.3 lumens/watt so for the same amount of energy consumed, it will emit more light.
The watts/efficacy way of specifying the emitters intensity is useful if you want to mimic common
lightsources, when the manufacturer provides the watt rating and the efficacy rating.

Luminous power

Lumen (Im). Lumens is the SI (International System of Units) unit for luminous flux. It is a common
way to specify how much light is emitted and light manufacturers usually supply this data.
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lluminance

Lux (lum/m?2). Lux is the unit for specifying illuminance. It is defined as one lumen per square
meter. This is a useful setting when you want to increase or decrease the size of your emitter,
and have it emit more or less light with the changed size of the emitter. With the previous setting
(luminous power), if you scale up your emitter for example, the amount of light emitted will be the
same, giving the impression that the overall light is dimmer. But in fact the same amount of light is
emitted, just over a larger area thus giving the impression that the emitter is weaker.

Luminous Intensity

Candela (cd). Candela is considered the base Sl unit for luminous intensity (the power of light
emitted in a certain direction).

Luminance nit (cd/m ™ 2)
One “Nit” is one candela per square meter.

Load Preset
Maxwell Render provides some emitter presets of standard type lightsources.

TEMPERATURE OF EMISSION:

A temperature in Kelvin degrees can be chosen. This will affect not only the colour but also the
intensity of the emission. A higher temperature will make the emission more intense. The colour will
change from RED (low temperature) to ORANGE —# YELLOWISH — WHITE —» BLUE.

MXI TEXTURE:

MXI is the Maxwell image format, it stores high dynamic range data and has a lot of advantages
over other high dynamic range formats, like the possibility to store a render in this format and
resume it later on. For more information on MXI format please see page 106.

This emission option allows you to texture an emitter with an MXI/HDR. The intensity of an MXI/
HDR map can be adjusted using MXCL. MXCL can also be used for converting regular bitmaps
or an HDR map into an MXI map. For more info about using MXCL for adjusting HDR maps or
creating MXI maps, see the section on MXCL on page 102.
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MIRROR-LIKE MATERIAL

—

The Nd was set to a high value here (1000) since we wanted a
totally reflective surface. The roughness was set very low in order
to have sharp reflections. The Reflectance 90° colour was set to full
white to have strong reflections. The Reflectance 0° colour was left
at default 128 grey (which such a high Nd the Reflectance 0° will
have almost no influence on the look of the material).
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> MATERIALS TIPS

In this section we will provide practical examples and tips to help you better understand the
parameters discussed above. We strongly encourage you to experiment with the material system,
in the beginning with simple one BSDF materials.

COMMON GLASS

Nd was set to 1.51 which is a reasonable Nd for glass. Following the relationship of Nd and the
Fresnel effect, we can use the Fresnel formulas to calculate that the reflectance of such a material
(with an Nd of 1.51) near incidence angle (looking straight on at the material) would be about 4%,
which translates into RGB at about 11. This is the value used for the refl 0° colour. Of course you
don’t have to calculate this value exactly, just know that for materials with the Nd around 1.5, the
refl 0° colour has a value of around 10-20. Of course you can always raise it if you want shinier
looking glass, but it's always good to know how this kind of material would behave in reality, if it's
realism you're looking for. Most glass materials have an Nd around 1.5.

COMMON GLASS
p

The reflectance 90° colour can be left at 255 since this glass will not tint the specular reflections,
and it will also reflect almost light at this viewing angle.

Transmittance was set to R:227 G:230 B:230 to give it a slight green/blue tint. The transmittance
was set a little low here to mimic a low grade glass with imperfections which give it a slight colour,
and it is not extremely transparent like high grade optical glass types.

Attenuation distance was set to 3cm which is a good value to use for common low grade glass.
Remember from the material section that attenuation distance is the distance the light travels N
through a material before losing half its energy. This means that for a glass panel 1.5cm thick

for example, the light passing through it and reaching the other side would have lost a quarter of

its strength. For high grade glass the attenuation distance can be much larger, even more than

five meters. Setting a higher attenuation distance means you’ll get clearer glass, since light can

easier pass through it.

Remember that attenuation distance and transmittance are parameters that work together. For
example you can have a low value transmittance (ex. 220, 210, 200), and starting with an attenuation
distance of 3cm you will get a pretty heavily tinted glass. Raising the attenuation distance now will
cause the glass to clear up. Ifinstead you raise the transmittance values but keep attenuation distance
at 3cm, the glass will become less colour tinted but will still be relatively dark.

Roughness was set to 0 for a perfectly smooth glass.
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PLASTIC & SHINY WOODEN FLOOR
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PLASTIC

A plastic material can be made by using a 2 BSDF material. It's best to set the blending mode
to Additive in the case of plastics (see Additive Vs Normal mode on page 35 for more).

The first BSDF is the plastics base colour. The refl 0° colour was set to 210, 210, 65. The refl
90° and Nd number does not matter and can be left as default since the material has Lambert
checked (100% diffuse surface).

The second BSDF will be the shiny “topcoat” of the plastic. The refl 0° colour was left at default
but you can lower or raise it to have an overall shinier plastic. The refl 90° colour was also left at
default since we want the plastic to be very shiny at the edges, and no tinting of the reflections.

Nd was set at 3 which is a good value for plastics.

The blending weight of the second BSDF was set to 30 to make the shiny BSDF have less
influence on the final material. This makes a more realistic plastic. Try to avoid having layers
all weighted at 100 when using Additive mode. This blending mode can produce unrealistically
reflective materials since their values are added together and not normalized in the same way
as in Normal blending mode.

To make the plastic more or less shiny, there are two possible approaches:

1. You can lower the refl 90° colour, and/or lower the Nd of the second BSDF to make it less
shiny. To make the plastic shinier, since the refl 90° is already at max you can raise the Nd.

2. You can increase the blending weight of second BSDF which will make this BSDF have more
influence on the final look of the material. Avoid increasing it too much beyond 30 in Additive
mode. (SEE ABOVE).

SHINY WOODEN FLOOR

The plastic material approach can be almost entirely copied for this particular material, we only
need to add a diffuse texture to the first BSDF, and a bump map.

The diffuse texture is added to the first BSDF (the lambert one), in the refl 0° slot.

The bumpmap is also added to this BSDF, strength set at two. Experiment with the bump value
and remember the bump parameter is pretty sensitive. Very high values (such as 40), can
produce unrealistic effects and longer render times.

The second BSDF can be left untouched except you can increase the roughness value to avoid
perfectly smooth reflections. For this image the rougness was set to 15. If the floor is too reflective,
the quickest way to change the amount of reflection is to lower this BSDFs weight value.
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WHEN TO USE REGULAR BSDF OR [OR FILES?

Suppose you work in jewellery and want to render gold (and only gold in its pure form) and you
don’t mind waiting longer for a high resolution image as long as the result is physically accurate
in the most precise way possible; capturing the subtle effects of light and the unexpected shifts
in colour as it would if a real gold object was present. In this situation the use of a complex IOR
material is best for you.

On the other hand, suppose you’re working on a two-minute animation of a gold robot for a TV
production. In this case you need speed and flexibility. For instance, you might want the gold
to look a bit redder and you might want it to reflect some blue light in areas. In this case the
extreme accuracy of an .ior file is not needed. In this case you can use a regular BSDF material
and adjust the parameters until you get something that ressembles gold in many respects. Your
custom-made gold is still following the physical laws of light for accuracy, while still being entirely
customizable and production-friendly.

The use of bsdf materials will also speed up rendering time. The biggest speed gain for bsdf vs .ior
files will be seen for glass type .ior files, metal .ior files will not slow down the render by much.

CLIPMAPS USING TRANSMITTANCE MAPPING

The transmittance map can be useful to simulate clipmaps. Clipmaps are defined by a black and
white bitmap used as a transmittance map.

Remember that the transmittance colour is defined as the colour obtained approximately at the
attenuation distance. However, there are two exceptions:

If the transmittance colour is pure black (RGB 0, 0, 0) the object is considered opaque.

If the transmittance colour is pure white (RGB 255, 255, 255) the object is considered transparent.
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> MAXWELL STUDIO
(MXST): INTRODUCTION

Maxwell Studio is a full, standalone application to render scenes and objects imported from other
3D applications. Maxwell Studio provides the following functionality:

* Import object files

« Set attributes of objects (position, rotation, scale, pivot, smoothing, normals, etc)
= Apply textures using UV projectors

* Apply physical materials and lights

« Visualize the 3D scene in graphical viewports

« Create multiple cameras and adjust their position and parameters

« Set sky options

« Fully customizable layout with the ability to save layouts

- Libraries of preset scenes, materials and layouts

& @ mxstudio File Edit Geometry Selection Render Window Help

NSNS

Maxwell Render 1.5 User Manual PAGE 57



CUSTOMIZING THE LAYOUT
p

\,

Displaying any panels is easy. Click on the Upper right icon to
access the list.

\,

y

You can divide your window by using the Split panel drop down menu.

\,

~N

Split Quad in the graphic viewport.
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CUSTOMIZING THE LAYOUT

Maxwell Studio’s layout is fully customizable. Each window can display any of the available built-
in panels by clicking in the upper left icon and choosing the appropriate panel. If a panel is already
open and it’s unique, its name will be greyed out.

Moving panels

Panels can be moved from their place to another by clicking their title bar and simply drag and
drop in another area of the layout. This makes it very fast and easy to configure a layout.

Undocking panels

Panels can be undocked from the main layout by clicking the icon in the [} title bar. Once a panel
is undocked, drag and dropping it in an area of the layout.

Opening a new floating panel

From the main menu option, click “Window” and choose which panel you wish to open as a
floating panel. Dock it by clicking its title bar and drag drop it into an area of the layout.

Removing a panel

Panels can be removed by clicking g in the title bar. The layout always reconfigures automatically,
expanding or stretching the rest of panels.

Splitting a panel

Panels can split vertically and horizontally, allowing new panels to be added to the layout. This
is the usual way to build a new layout, by splitting the existing panels and adding new ones. The
split quad option creates four new panels and replaces the original.
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Collapsing a panel

Panels can quickly be collapsed/expanded by clicking the [l button in the upper right corner of a
panel. A collapsed panel shows a light grey button when collapsed. Click it to expand the panel.
Collapsing panels is very useful to quickly make more space for other panels without having to
rearrange or close the panel.

Saving a layout

Once you are happy with your custom layout, save it from the main menu Window > Save Layout.
The file will be saved as an .stlay file.

Opening a layout

From the main menu choose \Window > Load Layout and navigate to a folder containing the .stlay file.

Quick switching between layouts
You can quickly switch between different layouts by using the drop-down list located in the top
row of buttons.

You can also switch layouts from \Window > Layout and choosing from the list of available layouts.
Make sure to save your custom layouts in the Maxwell/layouts directory on your computer so that
they appear in the list. You need to restart Studio for a newly saved layout to appear in the list.

Setting a custom layout as default

Saving any layout as “defaultlayout.stlay” will make it the default layout when Studio is launched.
It is recommended first that you rename the “defaultlayout.stlay” file in the Maxwell folder if you
later wish to reload the original default layout.

A set of layouts are available under the layout folder on the installation. These layouts are focused
on different tasks like mapping, rendering or editing.
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QUICK SWITCHING BETWEEN LAYOUTS
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You can always access different layouts quickly form the Layout menu.
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Panel Types

-

3D VIEWPORT

2D VIEWPORT

MATERIAL LIST

MATERIAL EDITOR

MATERIAL BROWSER

ENVIRONMENT SETTINGS
RENDER OPTIONS

OBJECT LIST

OBJECT PARAMETERS
CAMERALIST

CAMERA PARAMETERS
CONSOLE

HISTORY

“Background” section collapsed and then expanded.

NUMERICAL INPUTS

( R

\, y

You can change the numerical values by either typing new numbers or
pressing the middle mouse button and dragging.
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Maxwell Studio provides different panels for different functions. The panels can be accessed by
COLLAPSED AND EXPANDED PANELS - switching an existing panel or using the menu command Window to open a floating panel.

Perspective or camera viewport
Orthographic viewport

List of materials available in the scene
Advanced editing of the selected material
Browse material libraries

Physical sky / sky dome / HDR lighting options
General rendering options

List of all objects and groups of objects in the scene
Parameters of the selected objects

List of cameras in the scene

Parameters of the selected camera

Console messages

List of changes made in the scene

More detailed information about using each panel type can be found in the MAXWELL STUDIO:
PANEL TYPES section on page 71.

Most of the panels are divided into subsections to for a more efficient display of information. Click
on the section name to expand that section and click it again to collapse the section:

\, The numerical inputs can be edited by typing new numbers or pressing the middle mouse button and
dragging up and down to scroll the number. Press CTRL while using MMB to scroll faster through the
numbers. Alternatively you can use the scroll wheel of the mouse for quicker number scrolling.



USING THE VIEWPORTS AND CAMERAS

The viewports in Studio are OpenGL® based and display all the scene items (objects, cameras,
etc). You can create as many viewports in a layout as needed. Any panel can be switched to
display a 3D/2D viewport.

NAVIGATION:

These are the basic functions to navigate in the graphical viewports:

ALT + LMB = ROTATE CAMERA AROUND THE TARGET ORIGIN
ALT + MMB = PAN CAMERA
ALT + RMB = ZOOM IN/OUT CAMERA

ALT + CTRL + LMB = “slow-mode” — slowly rotate camera around the target origin.
Up/Down arrows on keyboard can be used to change how slowly the camera should move
in this mode. You can repeatedly press the Down or Up arrows to adjust, then use.
ALT + CTRL + left mouse button

ALT + CTRL + MMB = “slow-mode” — slowly pan camera

ALT + CTRL + RMB = “slow-mode” — slowly zoom in/out camera.

ALT + SHIFT + LMB = ROTATE CAMERA TARGET AROUND THE CAMERA ORIGIN
ALT + SHIFT + RMB = DISPLACE CAMERA ORIGIN ALONG THE LOOK-AT DIRECTION.
This also moves the camera’s focal point (camera target), along with the camera.

ALT + SHIFT + MMB = ROLL CAMERA

The last function is only available when the viewport is a camera view.

Additionally, there are quick navigation options when Rightclicking on any viewport:

“Reset Viewport” will reset the viewport to a default perspective view.

“Look at Selection” applies to both camera and perspective view and it centers the selection
on the viewport without changing the position of the viewer or the camera zoom.

“Center Selection” centers the current selection (objects and/or groups) in the viewport.
“Center Scene” centers the entire scene in the viewport.
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NAVIGATION OPTIONS
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Assign Material
Import...

Group

Invert

Select by Keyword
Select All
Deselect all

Merge Objects

Wireframe
Flat

Hide/Unhide
Unhide All

New Camera

el

3F
#A

#H

#C

Reset Viewport

Auto Focus
Focus to...

Look at Selection
Center Selection
Center Scene

Navigation options with the right mouse button menu.

Clone
New UV Set

Remove
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2D / 3D VIEWPORTS:

VIEWPORTS Maxwell Studio provides perspective and orthographic viewports. The buttons at the top of the
viewport allow you to quickly change between views:

“Perspective” allows you to change between the perspective/cameras point of view. When clicked,
a menu will appear listing all the available cameras and perspective view.

The “Shaded” option will change the display mode of the window. Please see the Display Modes
section for more details.

The button “3D” can be clicked to change to a 3D perspective view; by default it will show the last
active perspective in that window.

Clicking any of the other letters will changes the viewport to orthographic views.
“T” FOR TOP
“D” FOR BOTTOM
“L” FOR LEFT
“‘R” FOR RIGHT
“F” FOR FRONT
“B” FOR BACK
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DISPLAY MODES:

Maxwell Studio provides different display modes in the viewports. You can choose the appropriate
mode by clicking on the display mode menu on the viewport title bar.

The following shading mode options are available:

Bounding box: — only bounding boxes of the objects are shown.
Wireframe: — only lines are shown.

Hidden line: — like wireframe, but backfacing polygons are not shown.
Flat: — flat shading.

Toon: — cartoon shading.

Shaded: — smooth shading.

Texture decal: — textures are previewed in the viewport without shading.
Textured: — textures are previewed in the viewport with shading.

THE VIEWPORT GRID:

The grid visible in both 3D and 2D viewports gives you an indication of how big your objects are.
For the 3D viewport, there is a grid size indicator at the bottom right of the viewport showing
the current grid size. This indicator will change as you zoom in/out of the viewport and the grid
spacing updates. The number of the grid size indicator tells you the distance between two bright
lines of the grid:

For the 2D viewports, the grid shows size indicators starting from the scenes origin and they
increase from that point:
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DISPLAY MODES

GRID SCALE

Grid:0.5m

The Grid size is also indicated in the bottom right cornor of your window.

PAGE 63



DISPLAY PREFERENCES
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On the Mac this is under the MXStudio Menu > Preferences>OpenGL®

CREATING A CAMERA
P

#5 New Camera
Make Active
Rename
Hide/Unhide

Block/Unblock
Clone
Delete

Items
Icon Size

#C
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DISPLAY PREFERENCES:

Display preferences are found in the main menu “Edit > Preferences > OpenGL®”.

Set Colour
Colour of viewport backgrounds

Threshold
Maximum angle to merge polygon lines shown in the viewport (this is only applied to OpenGL®
display, no polygon lines are merged for rendering)

Enable Sky in new scenes
Physical sky will be on by default in new scenes

Vertex Buffers
Uses the vertex buffer feature of OpenGL® 1.5 to greatly increase viewport speed with heavy
geometry. Disable this feature if you experience problems or artifacts in the viewport display.

Smooth Antialiasing
Enable / disable line antialiasing

Lights
Number of lights used in OpenGL® viewports

Texture Res
Texture resolution to use in the OpenGL® viewports.

Show bounding box when navigating
Acceleration mode showing the objects as bounding boxes when rotating/panning/zooming in
the viewport.

CREATING A CAMERA:

By default Maxwell Studio has a perspective visualization mode that acts like a camera, but without
all the possibilities of a real Maxwell camera. You don’t have to necessarily create a camera to scene,
but we do recommend this so that you have more control over the final image look.

Use the viewport menu (Rightclick on viewport) and choose “New Camera” or press CTRL+C.
This will add a camera with the point of view of your current perspective view. You can create as
many cameras as you want. In the Camera list panel, Rightclick and choose “New Camera”.

Once a camera has been created, the camera frustum is displayed in the viewport. To switch to
a camera viewport, click the viewport switch button icon in the upper left corner and choose the
desired camera.
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Camera frustum (YELLOW FRAME)

The camera frustum is adapted according to the resolution of the image set in the Camera
parameters panel. When the render is launched from the camera view, only the region inside the
frustum is rendered. The same applies when you launch a viewport render.

Selecting any camera in the Camera list panel will display that cameras properties in the Camera
parameters panel.

MOVING A CAMERA:

Switch the viewport to “Camera View” and rotate, pan or zoom the view as explained earlier (ALT
+ mouse). This mode affects only the origin of the camera. In order to pan or rotate the camera as
well as the target of the camera, use the shortcuts ALT + SHIFT + mouse.

The camera can also be moved using its translate handles:

Left: Camera handles set to move the camera Right: Camera handles set to move the camera target.

To move a camera using its handles, select it from the Camera list panel, and press the move icon
from the top row of icons. The translate handles appear and you can move the camera without
moving its target. To move the target of the camera instead, press the “L key”.
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CAMERA FRUSTUM
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The yellow frame indicates the area of the camera frustrum
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DEPTH OF FIELD (DOF)

Vs

PAGE 66

To move the camera together with its target, press the L key again. Pressing the L key yet again
will switch to moving only the camera.

When the translate handles are set to move only the camera, the rotate button }i_#§ can be used
to roll the camera.

DEPTH OF FIELD (DOF):

Maxwell's cameras are designed to work like real cameras, so it is important to understand first
of all the concept of depth of field.

Consider the following image: The camera is pointing to the interest area (the koala). The focal
distance should be the distance to the object in order to get a perfectly focused image. The near
and far planes define the DOF area. Inside the DOF area, all objects are in focus.

near plane far plane

DOF

<N
A\ 4

Focal distance r g ™

N
A4
[
)R
.
R —.
7

The most important camera parameters to remember regarding the DOF are the fstop and focal
length. The smaller the fstop (1.8, 2.2, 2.8) the smaller the DOF, meaning only a small area of the
image will be in focus. With the focal length parameter, larger focal lengths will reduce the DOF,
for example 50mm, 70mm, 100mm. A focal length of 24mm (typically called wide angle) will have
a very large DOF, so almost all areas of the image will be in focus.
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The Maxwell camera has a visual focus indicator that provides information about the focus
conditions of the target. When the camera moves, the focus indicator changes according to the
distance to the objects from the camera.

The focus indicator is composed of two circles and a rectangular indicator just in the center of the
camera. When the target object (the central point of the circles) is exactly in focus, the rectangular
indicator turns to yellow, otherwise it remains black.

A black rectangular indicator does not necessarily mean that the render will be out of focus, it
also depends on the DOF distance. To measure if the camera target is inside or outside the DOF
distance, the circles use blue or red colours.

The area of the circle with red colour means than the specific target area is beyond the far plane.
Conversely, when the area of the circle is blue, the points are before the near plane. Areas in red
and blue mean “out of focus” zone. Transparent areas are in focus. The yellow mark is the exact
focal point.

Use the shortcut: Press the “I” key to disable or enable this information in the display.
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red = out of focus

Beyond far plane

Before near plane = blue = out of focus

THE NUMBERS NEAR THE FOCUS INDICATOR REFER TO:

FD = Focal distance

Near = Distance from camera to near plane
Far = Distance from camera to far plane
DoF = DofF distance (Far — Distance)
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FOCUS INDICATOR

( )

Focus indicator showing focus and out of focus areas. Focus is set
on the third closest sphere.

A\

For the Auto focus and Focus to options to work correctly, make
sure you are not in Bounding Box or Wireframe shading modes.
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Render

Two additional functions “Auto focus” and “Focus to” are very helpful to control the focus of the
camera. You can find these options by Rightclicking in the viewport.

Auto focus (key F)
Automatically focuses to the target point (what the focus indicator sees in the viewport).

Focus to...
Choose this option and then click any point of the viewport. The clicked object will be in focus.
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SHIFT LENS:

The Shift lens functionality of the Maxwell camera allows you to shift the lens of the camera in
order to move up/down, left/right the image that falls on the virtual film plane. This is useful for
architectural type renders where you want to keep some lines of the building parallel, making a
two point perspective.

X Offset: Defines the offset in X (side-side movement). Values can go from —100 to 100.

Y Offset: Defines the offset in Y (up-down movement). Values can go from —100 to 100.

ZCLIP:

ZClip planes allow you to cut away parts of the geometry in a render by specifying the near and far
clipping planes of the camera. This allows you for example to move the camera outside a room,
and cut away the wall facing the camera so you can still get a render as if the wall didn’t exist,
although the actual render will take into account the wall and produce proper lighting.

ZClip check box: Enables ZClip
/ Near: Define the near clipping plane. Anything before this plane will be clipped.
/ Far: Define the far clipping plane. Anything after this plane will be clipped.
The Z-Clip planes can be previewed either by looking through the camera in the viewport (you will

then see the object being clipped as you move the Z-Clip planes) or looking in a perspective view
and seeing the red (near plane) and blue (far plane) rectangles.

SEEING THE PLANES THROUGH PERSPECTIVE VIEW vs SEEING THE ZCLIP DIRECTLY THROUGH THE CAMERA.
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Resulting ZClip planes and a ZClip render.
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> PANEL TYPES

OBJECT LIST

Object list showing groups, objects and their materials

The Object list panel is where all the groups and objects in the scene are listed in an Explorer
style interface. The material applied to objects/groups are shown to the right. Further to the right
is a lock icon allowing you to lock an object to prevent accidental movement. You can still apply
a different material to a locked object. Each column in this panel can be resized by click dragging
on the column separators.

Assign Material:
Select one or more objects and/or groups and select this option to apply a material to the
selection.

Clone:
Create clones of your current selection

Group:
Select more than one object and select this option to create a group from the selection. A pop-up
will appear allowing you to name the group.

Ungroup:
Select one or more groups and select this command to ungroup the objects contained in the group (s).

Group Triangles:

Select an object and switch to triangle selection mode m select some triangles and choose this
command to make a triangle group from that triangle selection. The triangle group can be found in the
Object parameters panel under the “Triangle Groups” tab.

New UV set:
Select one or more objects and click this button to create a new UV set for the object (s).

Select all:
All objects and groups will be selected

Deselect all:
All objects and groups will be deselected
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Assign Material

“ Clone
4 Group

%y Group Triangles
New UV Set

Select All
Deselect all

Select by Keyword
Invert

Wireframe

Flat

Hide /Unhide
Unhide All

4 Merge Objects
% Remove
Rename

Items
Icon Size

HA
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#H

Rightclicking in the Object list

panel fo open its options.
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OBJECT LIST PANEL
p

& Group
Ungroup

- Group Trianc 1
2 Group Triangles

Select All
Deselect all
Select by Keyword  $F

#A

Unhide All

Merge Objects

Expand All
Expand Selected
Collapse All
Collapse Selected
| Sort Alphabetically

By Rightclicking on the Objects window you can gain quick
access fo the dropdown menu.
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Select by Keyword

A pop-up appears where you can enter a string of characters found anywhere in an objects name.
For example if your scene contains the objects named Glass container, Plastic container, entering
“contain” in the pop-up will select both objects.

Invert
Inverts the current selection.

Hide/Unhide
Hides or unhides the current object/group selection from the viewport display and rendering.

Unhide All
Unhides all objects in the scene that were hidden.

Merge Obijects
Select two or more objects and choose this command to merge them into one object.

Remove
Select one or more groups or objects. Choose this command to delete them. Note that objects in
the group (s) will also be deleted.

Rename
Select an object or group and choose this command to rename it.

ltems
This menu item contains several options:
Expand All — Expands all objects and groups.
Expand Selection — Expands all selected objects and groups.
Collapse All — Collapse all objects and groups.
Collapse Selected — Collapse all selected objects and groups.
Sort Alphabetically — Sort all objects and groups alphabetically.
Icon Size

Set the size of the icons displayed in the object list.
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OBJECT PARAMETERS

When a group or a set of objects are selected in the Object list panel, the Object parameters panel
will show the list of parameters that can be changed for that selection. The panel is divided into
several sections which can be expanded/collapsed by clicking on the section title:

| GEOMETRY SECTION

Position: XYZ world position of the object(s).
Rotation: Euler angles of the object(s).

Scale: XYZ scale of the object(s).

| PIVOT SECTION

Center pivot: Set the pivot point to the geometric center of each object.
Pivot Position: XYZ position of the pivot.

Pivot Rotation: Euler angles of the pivot.

| DISPLAY SECTION

Hidden: Hide/show the object from the display view. Hidden objects do not render nor take part
in the render.

Hidden from Camera: Hide the object from the render view but have it participate in the render
calculation (cast shadows, refract etc).

Hidden from Reflection/Refraction: Reflected or refracted objects are hidden (seen in enough
specular materials or with low roughness; like a vampire in a mirror).

Hidden from Gl: Means the object will render but will not affect lighting.

Exclude from ZClip: If this option is selected, the object won't be cut by zClip planes.
Show normals: Show the normals of the object in the viewport.

Normal size: The display length of the normals.

Shading Type: Choose the display mode for the selected object(s).
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Obiject panel with Geometry and Display sections expanded.
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OBJECT PARAMETERS 2
p

SMOQOTHING
p

A — B

Sphere A: with smoothing on.  Sphere B: with smoothing set to Flat.
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Normals: Reverse: This will change the renderable side of the polygon by changing
the direction of the normal vector. It is relevant with objects that have got
emitter or dielectrics materials applied
Recalc: Recalculate the objects normals. This parameter can help remove
rendering artifacts due to corrupt normals of an imported object.

Smoothing: Choose whether to smooth objects at render time, or if the object(s) should not be
smoothed (Flat).

Smoothing Angle: Angle of smoothing. If the angle between adjacent polygons is smaller or
equal to this angle, they will be smoothed.

LUV SETS SECTION

Displays all the UV sets belonging to the current object. Note that only one object has to be
selected for the list to display the UV sets. To know more about how to create an UV Set please
refer to page number 91.

| UV PARAMETERS

Lets you edit the parameters of the currently selected UV set. For more info about working with
UV sets in Studio, see section on page 91. To edit a UV set you need to set it to something other
than “Locked”.

Type: Lets you choose the type of UV set needed for the object. There are 4 types of UV sets
available: Flat, Spherical, Cylindrical, Cubic.

Channel: set the UV channel that this UV set will represent. The UV channel is used when
applying textures to a material in the material editor, you specify the UV channel that texture
should use. For example an object may have two UV sets, one spherical (channel 0) and one flat
(channel 1). A material applied to this object can use both the spherical UV set and the flat UV
set. In the material editor, you can set one texture to use channel 0 and another texture to use
channel 1.

Position: The position of the UV set relative to the position of the object it is applied to. 0,0,0
means the UV sets pivot is at the center of the object it is applied to.

Rotation: The orientation of the UV set relative to the orientation of the object it is applied to. 0,0,0
means the UV set has the same orientation as the object it is applied to.

Scale: The size of the UV set in meters. The scale is initially set to the bounding box size of the
object for cubic UV sets.

Adjust to object: Pressing this button will adjust the position and scale of the current UV set to
the global position and scale of the object it is attached to. Additionally there is a Locked type of
UV set. This is the type of UV set assigned to objects which already have UV information from
import. This UV set does not allow any editing. You can also set a current UV set to Locked to
avoid editing it by mistake.
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| TRIANGLE GROUPS

Show all triangle groups belonging to the selected object. Note that only one object has to be
selected for the list to display the triangle groups.

To view the triangles associated with a triangle group, make sure you are in Triangle Selection
mode [7 and select a triangle group. The triangles appear in the viewport.

You can drag and drop a material from the material list onto a triangle group to assign that material
to just that triangle group. You can also select a triangle group in the list, and then drag and drop a
material directly in the viewport. To remove a triangle group, select it and press the Delete key on
your keyboard. Additionally if you Rightclick on a triangles group a menu will pop up:

Merge: This will merge two selected groups and will leave the material of the first selected to the
new merged group of triangles

Recalculate: this option will recalculate the group to add or remove some triangles.
Rename: for renaming a group.

Remove: Same as delete key, it will remove the triangles group but not the triangles themselves.

MATERIAL LIST

All the materials currently loaded in the scene are listed in the material list, including those that
are not assigned to any object.

NOTE: To keep your MXS files tidy and clean we recommend you to Remove unused materials before
rendering. This way MXCL won't expend time looking for textures of unassigned materials.

If a material has already been previewed in the material editor, a smaller version of the preview
thumbnail will appear next to each material. If the material has never been previewed an icon with
ared X’ will appear next to it.

A material can also be dragged from the Material Browser panel into the Material list panel.

New Material: Create a new material.

New Emitter: Create a new emitter material.

Import MXM: Imports an .mxm (Maxwell material file) into the material list.
Clone Material: Creates a clone of the currently selected material.

Rename Material: Shortcut for this command is F2.

Remove Selected: Removes selected materials from the scene.

Remove Unused: All materials that are not applied to any object are removed.
Remove All: Removes all the materials from the scene.
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Material list panel

Renarne Material

Remove Selected
Remove Unused

Remaove &l

Select Assigned Objects
Select Assigned Triangles
Add Assigned Triangles
Remove Assigned Triangles

Reload Preview

Items »

Icon Size »

Rightclicking in the material
list reveals the following menu:
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MATERIAL BROWSER PANEL
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blackgicssyplastic  blusgioasyplastic  bofegiossyplastic  gresnglossy plastic
groygiossyplasic  hreglossyplasic  omngeglossy plasiic pinkglossy plasiic

(i
prussiant begiossy pumplegiossy plastic mdglossy plastic sionagiossy plastic
y
Material browser showing a selection of preset materials.
~

Set a materials folder in Studio preferences (Edit > Preferences > Paths)
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Select Assigned Objects: Select a material and choose this option to select all objects
that have this material applied.

Select Assigned Triangles: Select a material and choose this option to select all triangles
that have this material applied.

Add Assigned Triangles: If you already have selected some triangles in the scene, use
this option to add to that selection all triangles that have this material applied.

Remove Assigned Triangles: If you already have selected some triangles in the scene, use
this option to remove from that selection all triangles that have this material applied.

Reload Preview: Select one or several materials and choose this option to generate a
new preview for all the selected materials at once.

[tems: This menu contains the option to sort the materials alphabetically.
lcon Size: Set the size of the icons displayed in the material list.

MATERIAL BROWSER

This panel provides a way to browse the Maxwell materials available on your system. It is also
available in the MXED, the standalone material editor. For every MXM file found in the material
database, the material browser shows a small preview of the material.

Within the Maxwell installation folder there is a material database that you can browse. If you have
set a materials folder in Studio preferences (Edit > Preferences > Paths), the Material Browser
will open in that folder.

Assigning/adding materials from the browser is done by drag and drop, in one of three ways:

1. Drag and drop a material onto a selected object or group of triangles in the 3D/2D
viewports. This action will add the material to the current scene and assign it to the
object/ triangles.

2. Drag and drop the material to the material list (both from the browser in Studio or from
the browser in MXED). The material is added to the list, but not assigned to any object.

3. Drag and drop the material into the material editor (both from the browser in Studio or
from the browser in MXED). The material is added to the material list and is also opened
in the material editor for editing. The material is not assigned to any object.
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A material can also be dragged from the Material list into the Material Browser, which is an easy

way of creating your own material libraries. Several materials can also be selected at once and
dragged to the Material Browser.

o DRAG & DROPPING MATERIALS
A — from browser (MXST or MXED) to the selected object /triangles. -
B — from browser (MXST or MXED) to the material editor.

C — from browser (MXST or MXED) to the material list. ool okl

CAMERA PARAMETERS

The camera parameters hold all the settings for the Maxwell cameras. For more info about
working with the cameras, see the section on page 64.

Block: Checking this option will not allow to change the camera parameters.
Hide: Checking this option will hide the camera in the viewports.

[POSITION |

Camera: XYZ world coordinates of the origin of the camera.
Target: XYZ world coordinates of the target of the camera.

Focal distance: Distance from the camera to the camera target. N\
Roll Angle: Rolling angle of the camera (in degrees).

| OPTICS |
Shutter: The shutter speed, specified in 1/ n of a second.
fStop: Controls the aperture of the lens.
Focal length: The focal length of the lens.

[RESOLUTION

X res: The X (width) resolution of the image.
Y res: The Y (height) resolution of the image.

Keep image aspect check box: Keeps the image aspect ratio when changing the
width or height of the image resolution and/or the film back width/height.

Pixel aspect: Width—height proportion of the pixels. Useful when the rendering output
will be displayed on devices which have non-square pixels, such as television sets.
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DIAPHRAGM PANEL
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FILM BACK

Width: Camera film width.
Height: Camera film height.
ISO: Sensibility of the film.

(Higher ISO number means the virtual film is more sensitive to light).

[DIAPHRAGM

Diaphragm type: Choose Circular or Polygonal. This controls the shape of the “bokeh”
effect caused by bright spots in the image that are out of focus.

Blades: Number of blades (for Polygonal diaphragm).
Angle: Angle of the blades (for Polygonal diaphragm).

|ROTARY DISC SHUTTER

Shutter Angle / FPS:

Enabling this check box allows the amount of motion blur in an image to be affected properly by
the Shutter Angle parameter found in animation cameras. For still camera photography (Maxwell
Render’s default), the amount of motion blur in an image is controlled by the Shutter Speed
parameter. The lower this value is, the longer the shutter is open, and the more pronounced
the motion blur will be. However, for animations — where you are replicating a film camera - the
shutter speed is generally fixed to a certain speed, usually 24 frames per second (1/24). Since film
cameras can’t control the amount of motion blur by changing the shutter speed, they instead have
a rotating disc with an adjustable pie-shaped cut out on it, which controls how long each frame is
exposed. The width of the cut-out is called Shutter Angle, and is expressed in degrees. Fully open
(180 degrees) will yield the maximum amount of motion blur, while a very narrow setting (say,
15 degrees) will produce very subtle motion blur. This feature automatically translates your usual
1ISO/Shutter speed settings in combination with the Shutter Angle, so your animation exposure will
match your still image exposure, while producing the proper amount of motion blur.

Maxwell Shutter (exposure) = FPS * 360 / Shutter Angle
Shutter Angle = FPS * 360 / Maxwell Shutter (exposure)
% of blur = Shutter Angle * 100 / 360
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CAMERA LIST

This panel lists all the cameras in the current scene. Rightclicking in the camera list panel shows
a menu with the following options:

New Camera: Creates a new camera, shortcut Ctrl+C or Command+C (Mac)

Make Active: This option will set the selected camera as the rendering camera and also switch
the viewport view to this camera.

Rename: Rename a camera, shortcut F2.

Hide/Unhide: Hide or unhide a camera from the scene. The camera can still be used to render.
Block/Unblock: Block or Unblock a camera to prevent accidental movements.

Clone: Clones the currently selected camera.

Delete: Select one or more cameras and choose this option to delete them from the scene.
ltems: Sort cameras alphabetically.

lcon Size: Set the size of the icons displayed in the camera list panel.

ENVIRONMENT SETTINGS

Environment lighting options in Maxwell Render are grouped under this panel. Choose from the
drop-down list the type of environment lightning you want:

NONE:

This will turn off all environment settings. Perfect for setting up emmiter based projects.

SKY DOME:

This option represents a uniform colour sky. Click the “Settings” tab to expand its settings.

Set Colour:
Clicking on this button will open a colour picker to choose the dome colour.

Lumens:
Type in the intensity of the sky dome in lumens.

PHYSICAL SKY:

Maxwell Render provides a physical sky model that reproduces the skylight conditions at different
locations/dates/hours. When the sky is enabled, the viewport shows a visual representation of the
sky that can be enabled and disabled by pressing the ‘K’ key.
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You can select any camera in the list by clicking on it. By Rightclicking
in the camera list panel will display the panel dropdown menu.

ENVIRONMENT SETTINGS PANEL

-
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ENVIRONMENT PANEL
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| LOCATION TIME

Longitude/Latitude: Earth positions to calculate the sky/sun light direction.

Date: Set the date.

Time: Set the time.

GMT offset: Set the Greenwich Mean Time offset of the longitude/latitude location.
Now: Press this button to set the time and date to your computer’s current time and date.

Auto: Enables the Auto GMT function. This function updates the GMT automatically as you move
the Sky globe or change the longitude/latitude.

City: List of cities for quickly choosing a location. The list is a text file which you can edit to add/
delete locations. It can be found in your Maxwell install folder (cities.txt).

Ground Rotation: Allows you to rotate the north direction. This is useful when you want to
reposition the sunlight without changing the location or date/time settings which would change
the sky illumination.

Google Earth™ Data: Allows you to import a KML file to set the location.

| ATMOSPHERE

Sun: Enable or disable direct sunlight. The direct sun light can be enabled or disabled independent
from the sky light.

Turbidity / Ozone / Water: Physical properties of the sky, slightly affect the colour components of
the sky. Increasing turbidity gives a warmer yellow tone, increasing Ozone gives a colder blue tone.
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| SKY GLOBE

You can interactively rotate the Earth in the display, to change to a different location. Use
Alt+LMB to rotate and Alt+RMB to zoom in/out. The shortcut key “K” enables or disables the sky
representation in the graphical viewport.

The graphical viewport shows the geographical directions (N, E, S, W) by means of a compass
located in the bottom left corner. The sun is represented by a small yellow sphere that points to
the sun direction. When the sun is below the horizon, the yellow sphere fades to black.

IMAGE BASED:
Applies an HDR or MXI image file to a spherical environment. These two image formats store high
dynamic range data, providing accurate environment lighting.

NOTE: that there are several available channels for specifying MXI/HDR maps; this is a very powerful
feature as it allows the user to have more control over the effects of the environment on the scene. For
example you can use one MXI/HDR map for illuminating the scene, and another map for the reflections.

Background channel: Allows the addition of an MXI/HDR map as a background environment, not
for emission purposes but for having a background image in the scene. Screen mapping can be
used to map the MXI/HDR image to screen coordinates.

Reflection channel: Add an MXI/HDR map for reflections on scene objects.
Refraction channel: Add an MXI/HDR map for refractions on scene objects.
[llumination channel: Add an MXI/HDR map as a background emission.

Each channel can be edited separately. The following options are available for each channel:
Browse button: For selecting the MXI/HDR map.

Disable channel: Map will not be used for rendering.

Intensity: Adjust the contribution of the map for scene illumination/reflections/refractions.
Scale: For scaling the current map.

Offset: For rotating the spherical environment. 0 to 1 represents 0 — 360°.

NN\

Maxwell Render 1.5 User Manual

COMPASS

Compass and Sun direction

\,

The Image Based dialogue panel

PAGE 81




RENDER OPTIONS PANEL
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The General options panel is highlighted here.
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Sky used in disabled channels adds an extra control over the environment. If any MXI/HDR
channels are disabled, you have the option to use the SkyDome, Physical Sky or None to replace
the disabled channels.

Additionally there is a “Copy to All” button in the Background Channel section. This lets you copy
all the settings including the map from the Background Channel to all the other channels.

RENDER OPTIONS

The “Render Options” panel shows the different controls related to the rendering process:

| GENERAL

Time (min): Set the maximum render time (in minutes) for the render. The longer the time is, the
cleaner and more accurate the image you will obtain.

Sampling Level: Maximum sampling level required. The render will stop when this SL is reached.
As with the “render time” parameter, the higher sampling more accurate the image you will obtain.

CPU Threads: Number of threads dedicated to the render. By default 0 threads means that all
available CPUs are used. In special situations you may require less threads if the machine is
working on other tasks. Note that one core in a multi core CPU is considered 1 CPU thread.

Low Priority: Enabling this option gives the Maxwell render process a low priority. Useful if you
wish to work on your computer while rendering.

Maxwell will finish the rendering process when one of these conditions “Render time” or “Sampling level” is
met. If you want to finish at some specific render time, set a very high sampling level, and conversely, if you
want to reach a specific sampling level, set a very high render time.
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[OUTPUT

MXS: Specify a name and path for the current scene to be rendered. You can specify another name
than the currently loaded scene and Studio will save it under that name before starting the render.

IMG: Specify a name along with suffix (eg. .jpg, .bmp, .tif, .tga, .png) and path for the image file
created when rendering. An image file is always created when rendering, if you don’t specify a
path and name, it will be saved as “default.png” in your Maxwell install folder.
NOTE: If you have specified a “Renders” path in your Studio preferences, you can simply enter a name
with suffix without specifying the path and the image file will be saved to that folder.

MXI: Specify a name and path for the .mxi file created when rendering. An mxi file is always created
when rendering, if you don’t specify a path and name, it will be saved as “default.mxi” in your
Maxwell install folder.

NOTE: If you have specified an mxi path in your Studio preferences, you can simply enter a name without
specifying the path and the MXI file will be saved to that folder.

Multilight™ Enobled: Enables the Multilight™ feature.

Disable Bitmaps: No textures will be used when rendering and all materials will be replaced by
a default Maxwell material.

Command Line: Text box where you can enter any command line option (please refer to page
111). Any of the commands entered here will overwrite the render options. As an example, you
can render to a test resolution from command line without losing the final render parameters
specified in Resolution parameter in the Camera Parameters panel.

Burn: Parameter to control the highlights in a render. Lower burn values will decrease the intensity
of the highlights to avoid “burned out” areas in the image. In most cases this parameter should be
left at default. Lowering it too much may produce unnatural looking images.

Monitor Gamma: Maxwell internally uses a gamma of 2.2 to convert from spectral space to
RGB space. You can use this parameter to control the gamma conversion. Lower gamma values
darkens the image, higher values lightens the image. Note that you can control this parameter
interactively while rendering in MXCL.
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|RENDER CHANNELS

Several render layers are available, useful for compositing tasks. Calculating more layers will take
extra time at the beginning of the rendering phase. The output will be saved in the same directory
as set in the MXCL Render Path.

Render: Output the main render image.
Alpha: Output the alpha image.
Object ID: Output multicoloured material silhouettes.

zBuffer: Output an image representing scene depth within the two values specified in zBuffer
range. The range is in meters.

Shadow: Shadow Pass shows the cast shadows of the materials with the “Matte Shadow” Flag
enabled.

Material ID: Output multicoloured object silhouettes.

LILLUMINATION LAYERS

Choose whether to render direct lighting, indirect lighting or both. Render time could be slightly
reduced when disabling any of these layers.

Direct: Enables the direct lighting render layer. Direct lighting is considered light that falls directly
on objects.

Indirect: Enables the indirect lighting render layer. Indirect lighting is considered light that has
already bounced off of another object.

[CAUSTICS LAYERS

Controls the rendering of caustics. Render time could be slightly reduced when disabling any of
these layers.

Reflection — Direct: Enables the direct reflected caustics (if direct layer is enabled). These are
caustic light patterns caused by direct light bounced off reflective objects.

Reflection — Indirect: Enables the indirect reflected caustics (if indirect layer is enabled). These
are caustic light patterns caused by indirect light bounced off reflective objects.

Refraction — Direct: Enables the direct refracted caustics (if direct layer is enabled). These are
caustic light patterns caused by direct light going through refractive objects.

Refraction — Indirect: Enables the indirect refracted caustics (if indirect layer is enabled). These
are caustic light patterns caused by indirect light going through refractive objects.
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L VIEWPORT PREVIEW |
Set the options for the preview rendering in the viewports. HISTORY PANEL

Bounces: Number of bounces for the preview renderer (more bounces, the slower and more
accurate the preview).

Priority: Set the CPU priority of the viewport preview rendering.

HISTORY

The History panel records almost all edits you make in Studio and lets you step backwards or
forwards through the list of changes. Simply select one of the entries to move through the history.
You can purge the history list from Edit > Purge History.
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> WORKING WITH OBJECTS:

IMPORTING OBJECTS IMPORTING OBJECTS .

Currently, the file formats supported are: MXS, OBJ, STL, LWO, XC2, DXF, 3DS, FBX (All Plan

2005). Some of these formats only store one single object while others support any number of Object _1 already exists in scene
objects. Maxwell requires these formats to provide 3D polygonal data as triangles. Other geometry
formats are not supported. Aename the new one

Rename the old one

Another alternative to importing geometry into Studio is to save a MXS scenes (Maxwell scene file
format) with the Maxwell plug-in for your application, and opening or importing that scene into Studio. Ignore the new one

) ) ) ) ) ~ Replace the old one
There are three possible ways to import objects into Studio:

Keep materials assignment
1. Use the menu command “File > Import”. =
2. Rightclick in a graphical viewport, and choose “Import”. v Keep UVs assignments
3. Drag and drop an object from your file explorer into the object list panel or viewports. v Keep object parameters
Overwrite all the parameters

When Maxwell Studio saves the scene, the geometry is packed in an MXS file, therefore the
original object files are no longer needed.

Apply Apply to all

RENAMING OBJECTS 4

Select an object and press F2 to rename it. N >

REPLACING OBJECTS

If you need to replace an object in the scene with an updated one, you can simply reimport it and
Maxwell will recognize an object with the same name already exists in the scene and show you
this pop-up asking you what do with the new object:

This is a very practical feature, as the geometry of the objects can be changed without removing
all the material properties.

USING PRESET OBJECT LIBRARIES

It is also possible to load any of the preset scenes and objects available with the installation by
clicking on “File > Load Environment” and “File > Load Object from Library”.
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SELECTING OBJECTS

BET «APE (0BT E",

« Objecto [ ¥ yelowgloss...

Make sure you are in object selection mode:

SELECTING BY USING A REGION

-

MOVE/ROTATE/SCALE

|
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By loading any of the environments the user will have a studio-like environment to render their
own objects. Please note the environments are set to match a certain scale, please keep this in
mind when choosing an environment. Users can also create their own environments and objects
by simply saving their scene in the “studio environments” folder or the “objects library” folder found
in the Maxwell install folder. They will then be available from within Studio for quick loading.

SELECTING OBJECTS

Objects can be selected in the 2D/3D viewports by clicking single objects with the left button or
dragging a region with the left button pressed. Selected items will be highlighted.

Shift + Left click — will select additional objects.
Ctrl + Left click — will deselect the object.

Press ESC to deselect all objects.

The objects can also be selected in the Object List Panel. Shift and Ctrl can be used as with the
viewport selection.

Selecting by using a region
There are more options for working with object selections, available by Rightclicking in the 3D/2D

viewports, or in the Object list panel. These options are explained in the MAXWELL STUDIO:
PANEL TYPES section on page 71.

MOVE / ROTATE / SCALE

In order to move, rotate or scale any objects, they must be selected previously. You can edit one
or more objects at the same time. Switch to object editing mode using the icons in the upper
toolbar or using the keyboard shortcuts Q (all), W (move), E (rotate), R (scale).

You can move, rotate or scale the selected objects dragging the axes or using the numerical inputs
in the Object parameters panel. For the numerical inputs, you can press the middle mouse button
inside an input box, and drag the mouse up/down to interactively change the values.

Press ESC to exit object editing mode.
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SELECTION MODES

There are different selection modes accessible through the icons in the main toolbar or with the
keyboard shortcut ‘T’. By default, the selection mode is set to “Object”.

n Object selection: Select objects.

n Group selection: Select only groups.
UV set selection: Select only UV sets.
n Triangle selection: Select only triangles.

©

Extra features to improve the triangle selection process are available from Selection > Polygon
Selection and Selection > Polygon Selection Mode:

Material selection: This is useful to “pick” the material assigned to an object or face.
The material will be selected in the Material list panel.

Selection menu

+ Key will expand the selection to the neighbour faces. Pressing the key ‘+' several times will
propagate the selection to the next neighbor faces of the current selection. Faces you want to
become selected must be connected.

- Key will do the opposite of key ‘+' reducing the selection to the inner neighbor faces.
/ Key (sLasH) will expand the selection to contain all the connected faces.

+ Key (AsTERIsK) will invert the current selection.

Key F8 = F92 = F10 — F11 switch amongst different triangle selection modes:

Set expand to facet selection mode will select facets instead of triangles.

Set raycast polygon selection mode will select both front and back faces of an object.
Set front-face polygon selection mode will select only front facing triangles.

Set paint polygon selection mode allows you to drag the mouse to paint the selection over the
surface. Use the SHIFT key to select more triangles while dragging the mouse.
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In editing mode, it is not possible fo select other objects using
the left mouse button. You can either press ESC to exit the editing
mode, or use the middle mouse button to select a different object.

SELECTION MENU

\,

Expand
Expand koBoundary
Collapse

Invert

Expand ko Facet

Raycast
Fronk Face:

You can expand your selection by navigating through the drop
down menus or by using the keyboard short cuts.
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WORKING WITH GROUPS

\,

Assign Material

“ Clone

4 Group

oup

B Lroup iriangles

a New UV Set

Select All
Deselect all

Select by Keyword
Invert

Hide /Unhide
Unhide All

4 Merge Objects
¥ Remove
Rename

Shading Type

Icon Size

Expand All
Expand Selected
Collapse All
Collapse Selected

Sort Alphabetically

y

More options for working with groups are available via the Rightclick menu.
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WORKING WITH GROUPS

Obijects can be grouped by selecting the objects to be grouped and choosing “Create group from
object selection” from the Rightclick menu in the viewports, or the Object list panel. Objects can
be moved from one group to another, or removed from groups by dragging them out of the group
in the Object list panel.

More options for working with groups are available via the Rightclick menu in the Object list panel.
Please note that depending on the type of selected item, some of these options won’t be available.

Group: Select more than one object and select this option to group the objects.

Ungroup: Select one or more groups and select this option to remove the objects from the group. The
objects will be placed outside the group, they won't be deleted from the scene.

Expand All: Expands all the groups in the object list.
Expand Selected: Select one or more groups and select this option to expand the group(s).

Collapse All: Collapses all the groups in the object list.
Collapse Selected: Select one or more groups and select this option to collapse the group(s).

Groups can also be moved and rotated using a single pivot point. Select the group and press the
Move / Rotate / Scale. A single set of transform handles will appear.

MERGE OBJECTS

Select two or more objects, Rightclick in the Object List Panel and choose Merge. The separate
objects will be merged into a single object. This is useful to simplify your scenes (merge for
example all objects that share one material), or to merge emitters to reduce the number Multi
Light sliders in MXCL.
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> MAXWELL STUDIO (MXST):

TEXTURING & ASSIGNING MATERIALS
MAPS AND TEXTURES

Maxwell Studio provides built-in features to map textures to objects using different UV sets.
Maxwell Studio also reads the UV mapping information exported from the 3D applications by the
Maxwell plug-ins.

In order to texture an object, we need to introduce the concept of an UV set first. An UV set is an
object property that tells how to map a 2D Bitmap onto the 3D object surface. There are different
kinds of UV sets: cubic, spherical, cylindrical and planar to project the Bitmap according to the
desired effect.

CREATING A NEW UV SET

Select the object and Rightclick in the viewport, or click the Geometry menu and choose
“New UV Set”.

The new UV set will be added to the UV Sets section in the Object parameters panel (where all
UV sets belonging to the object are listed).

Every UV set contains a set of editable parameters. These parameters are available in the Object
Parameters Panel — UV parameters section. You can add as many UV sets as you want to a
single object. Every UV set will be given a unique “channel” number.

For details about the parameters in the UV set parameters panel, please see page 74.

UV SET — CHANNEL ID

It is important to understand that the channel ID of the UV set is the way for Maxwell Studio to
know which texture should use which UV set. You specify this channel number in the material
editors texture picker:

For example, if you have two UV sets applied to an object, one cylindrical with the channel ID of
0, and one flat UV set with the channel ID of 1, and you want to map a texture to the object using
the flat UV set, then you must specify in the texture picker for it to use Channel: 1.
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MAPS AND TEXTURES

Cubic, Spherical and Planar UV sets.

CREATING A NEW UV SET

-

\,

Edit Selection Render Window Help
% Clone
Group Triangles
&, New Camera ¥C
B, New UV Set

4 Group

Ungroup

Or alternatively select the object and Rightclick in the viewport.

CHANNEL ID

\

The Channel ID is located here in the Texture Icon pop up window.I
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CUBIC UV
P

An object with a cubic UV set applied (white square).
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ADJUSTING A UV SET

The UV sets can be moved/scaled/rotated in the viewports, the same as with objects, or you can
use the numeric inputs in the UV parameters section of the Object Parameters panel.

You must select the UV set first, from the UV Sets section of the Object Parameters Panel. To see
the projector in the viewport, switch to UV set selection mode:

This selection mode allows you to move/rotate/scale only UV sets and not the object itself.

CREATING A NEW MATERIAL

Rightclick in the Material List panel and choose “New Material”.

IMPORTING A MATERIAL

Rightclick in the Material List panel and choose “Import”. Browse to a folder containing an mxm file.
When importing a material with textures, Studio will look for the textures in the following order:

The paths contained in the material itself.

The folder where the mxm is located.

The folder of the currently opened scene.

The five texture paths set in the Studio preferences (Edit > Preferences > Materials > Textures).

If Studio still can’t find the textures it asks the user to locate them.

ASSIGNING A MATERIAL TO A SINGLE OBJECT

Three possible ways:

1. Select the material in the Material List panel and drag it over the object in the Object List Panel.
2. Rightclick the object in the Object List Panel, and choose Apply Material > Your material.

3. Select the material in the Material List Panel and drag it over the object in the viewport. If one
or more objects were already selected the material is applied to the selection. If no objects were
selected a red bounding box appears on the object that will receive the material.
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ASSIGNING MATERIAL TO SEVERAL OBJECTS

Select one or more objects in the viewport or the Object list panel. Select the material in the
Material list panel and drag it over the selection in the Object list panel or in the viewport.

ASSIGNING MATERIALS TO GROUPS

Select the material in the Material list panel and drag it over the group in the Object list panel.

ASSIGNING MATERIALS TO TRIANGLES

Enter triangle selection mode :I and select some faces. Select the material in the Material list
panel and drag it over the faces selected in the viewport. Alternatively you can drag and drop a
material over an existing triangle group in The Triangle Groups section of the Object Parameters
panel. The material will appear next to the triangle group.

RENAMING A MATERIAL

The material name can be changed by pressing F2 with the material selected in the
Material List panel.

ENABLING/DISABLING TEXTURES

Textures can be enabled or disabled using the check box to the left of the texture icon.

ADDITIONAL TEXTURE OPTIONS

Options for tiling and offsetting the texture are found in the texture picker. For details on these
options, please see the Material Editor Panel section on page 28.
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You can easily drag and drop all your materials within the window.
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> MAXWELL STUDIO (MXST):
RENDERING

VIEWPORT RENDERING

Rendering can be done directly in the 2D/3D using the following buttons on the right:

Depending on whether a camera or perspective mode is active, the render will cover only the camera
frustum or the full window. Also, the render can be launched from an orthographic view.
To cancel the render process, click anywhere in the viewport.

BLOW UP REGION

This rendering command allows you to draw a render region in the viewport, and render that
region at the full resolution set in the camera settings. The ratio of the render region will be
kept. For example if you draw a render region 200x400 pixels (a ratio of 0.5), and the camera
resolution set to 500x500, the rendered blow up region will be 250x500 pixels.

SENDING THE SCENE TO MXCL RENDER/VIEWER

Press the render icon in the top row of icons: 4 This will send the .MXS to the MXCL Viewer and
start the render. More info on the MXCL Viewer options can be found on page 102.

Render options for both viewport rendering and rendering via MXCL are found in the Render
Options Panel. A detailed explanation of each option is found on page 82.

Shortcuts:

CTRL + P = Preview
CTRL + SHIFT + P = Render

Preview Vs Render

Both commands “render” the scene, but the preview render uses the Maxwell preview render
engine called RS0, while the Render command uses the main render engine called RS1. Preview
rendering will be faster but of worse quality. It can be useful however for checking light levels and
if textures are mapped correctly to objects.
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RENDER REGION
RENDER VIEWPORT
PREVIEW VIEWPORT
RENDER

BLOW UP REGION
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PACK AND GO... FUNCTION

This function can be accessed from File > Pack and Go. The Pack and Go function lets you copy all
materials/textures/ior files used in the scene, as well as the scene file itself, to a folder of your choice.
This makes it very easy to share scenes with other users, or use the Pack and Go function if you
want to quickly organize your scene, making sure you have gathered everything that is needed.
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> MAXWELL STUDIO (MXST):
PREFERENCES !

The Preferences can be accessed from the top menu, Edit > Preferences.

GENERAL

Delete temporary files when closing: When exiting Studio, this option will delete the temporary
.MXS files created for rendering.

APPEARANCE:

Load Studio look: This option will display the Studio default grey look.

PREFERENCES PANEL — GENERAL

Show RGB colours in axis: In object and camera panels, the X,Y,Z axis numeric input boxes can
display a color, indicating the axis of the numeric input (X=Red, Y=Green, Z=Blue).

Check for updates automatically: By selecting this checkbox Maxwell will check for any new
Maxwell Render updates available.

lcons size: Set the default icon size for objects, materials and the toolbar. PREFERENCES PANEL — PATHS
-
WARNINGS

You can specify here whether Studio should show warning pop-ups before proceeding with
operations such as deleting objects and materials. “Do not show material performance warnings”
check box is used for hiding pop-ups when you turn on dispersion or load an .ior file in the material
editor.

PATHS

You can specify here the default paths that Maxwell should use. Paths can be set for: Scenes,
Materials, Textures, Renders, Temp .MXS files (used when rendering through MXCL viewer),
Default mxm.
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PREFERENCES PANEL — OPEN GL®

-

PREFERENCES PANEL — IMPORT OPTIONS
-

-
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OPENGL®
APPEARANCE

Set colour: Colour of viewport backgrounds.

Threshold: Maximum angle to merge polygon lines shown in the viewport (this is only applied to
OpenGL® display, no polygon lines are merged for rendering).

Enable sky in new scenes: Physical sky will be on by default in new scenes.

PERFORMANCE

Vertex Buffers: Uses the vertex buffer feature of OpenGL® 1.5 to greatly increase viewport speed with
heavy geometry. Disable this feature if you experience problems or artifacts in the viewport display.
Smooth AA: Enable / disable line antialiasing.

Lights: Number of lights used in OpenGL® viewports.

Texture Res: Texture resolution to use in the OpenGL® viewports.

Show bounding box when navigating: Acceleration mode showing the
objects as bounding boxes when rotating/panning/zooming in the viewport.

IMPORT OPTIONS
MXS IMPORT OPTIONS:

Create one UV set per each object loaded: If an object in an .MXS file (generated by a plug-in
for example) does not have any UV information, this option will create a UV set for the object.

Normalize UVs of objects with real scale applied: If some objects in the MXS file are assigned
materials which have real scale enabled, this option will normalize the UVs of those objects so that
the textures will be displayed and rendered properly for those objects.

Create triangle groups automatically in multimaterial objects: This option is useful forimporting
older mxs scenes, in which case Studio will create the triangle groups for each imported object that
had multiple materials applied to it. If this option is off, Studio still imports the objects correctly, with
multiple materials applied, but you will not have any triangle groups to edit in case you want to add/
delete to the triangle selection or apply other materials to the triangle groups. Please not that for a
scene with many objects, turning this option on will increase scene loading time. The newer plug-ins
automatically create triangle groups so this option is not necessary.
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OBJ IMPORT OPTIONS:

Create one UV set per each object loaded: If an object in an .obj file does not have any UV
information, this option will create a UV set for the object.

DXF IMPORT OPTIONS:

Create one UV channel per each object loaded: If an object in an .dxf file does not have any
UV information, this option will create a UV set for the object.

Create one material per group: DXF layers will be imported as groups in Studio and this option
creates and assigns the same material to all objects part of that group.

Launch material conversion table: When importing a dxf with several layers, this option brings
up the material conversion table which lets you specify which material should be assigned to
which layer.

Scale factor: Lets you specify the scale that was used for creating the dxf file. If your dxf was
created using meters, leave this option at 1.000. If it was created using mm, set this option at
0.01. If created in cm, set it to 0.1.

Rotation (X, Y, Z): Lets you change the rotation of the dxf file for systems that use the Z axis as
the up axis for example.

SHORTCUTS

Allows you to set your own shortcut keys for Studio commands.
View keys: You can see in this menu all the keyboard shotcuts listed.

Invert rotation: Allows you to invert the rotation behavior when rotating the view in the
graphical viewports.
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PREFERENCES PANEL — MATERIALS

-
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MATERIALS

Set texture paths and material editor preview options.

TEXTURES:

Extension independent textures: This feature is very useful if you wish to convert a series of materials
that use textures in one format, to materials that use the same textures, but in another format.

For example, if you have 100 materials using only .tga textures and you have converted those

textures to .jpg to save space (and kept the same texture names), drag and drop all your materials
from the Material browser into the Material list panel in Studio (you can select all of them and
drag and drop all materials at once). Studio then sees that the .tga versions of the textures are no
longer available and instead searches the same textures by name, but with a different extension.
This way all your materials have been instantly converted to use the .jpg version of your textures.
If you wish you can now select all your materials from the Material list panel, and drag and drop
them back into the Material Browser for later use.

|OR files: set the location of the IOR material files.

PREVIEW:

Quality Factor (1-10): This defines the quality of the preview render, higher is better.

Bounces: Number of times light rays should be allowed to bounce. If your preview scene contains
complex objects, or several in front of another and you want to preview a transparent material,
raise this setting if you get black parts in the preview.

Scale Reduction: Specify the scale reduction of the preview thumbnail. This will help speed up
material preview renders.

Use RST engine for the material preview: Normally, the preview renders use the RSO render
engine, which is the preview render engine. Checking this option will instead use the final rendering
engine, RS1, for making the material preview renders. It is useful if you want more accurate material
preview renders. Render time of the preview will be increased using this option.
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> MAXWELL RENDER

VIEWER (MXCL)

MXCL provides a standalone interface that allows users to load .mxs scenes to render, view the
rendering progress and adjust render parameters. Many of the parameters can be adjusted while
MXCL is rendering. While adjusting parameters, the small preview image is updated in realtime.

MXCL also allows users to load .mxi files, the Maxwell native file format. An MXI file is always
created when rendering with Maxwell. It contains high dynamic range image data and other
Maxwell Render data.

This interface is opened automatically when the render button s pressed in Studio. To display
it also when rendering from command line, the option —display or -d is used.

The Maxwell Viewer provides a visualization of the render in progress, controls to tune the image

while the render is in progress, including tone mapping, interactive Multilight™ control, interactive
fstop and shutterspeed and more.

FILE MENU

Open MXS

Open an MXS file for rendering. Press the icon to start the render.
Open MXI

Open an MXI file for viewing and modifying.

Save MXI

Save an MXI file.
Cooperative MXI

Lets you manually merge a group of mxi files generated in cooperative render mode. Select
several mxi files at once in the file browser, click open, then MXCL will ask you where to save a
merged MXI.

Load Image

Load a bitmap file. You can load both LDR (.jpg, .tif etc) and HDR files. You can adjust their
brightness using the intensity slider in MXCL and then save them as an MXI file to use as an MXI
emitter in your scenes.
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The MXCL interface
FILE MENU
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FILE MENU

-

" & mxa |

‘806 Open MXS %0
Load MXI 30
Save MXI {385
Cooperative MXI
Load Image 30
Save Image C38S
Recent MXS >
Recent MXI >
\,
CONSOLE TAB
-

\,

The Console Tab window.

Display/Hide the current render in MXCL

Start/Stop/Resume the current render.
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Save Image:

Save a bitmap of the render view. You must specify a file suffix when saving, for example myimage.
tga, to save the render as in .tga format. Currently supported output formats are: .bmp, .tga, .jpg,
.png, tif, .hdr.

Exit
Exit MXCL viewer.

RENDER STATUS BAR

SL = Current sampling level.

Next SL = Time to next sampling level.

Update = Time to next image update between samples.

Time passed = Total time elapsed.

Time left = Time left to finish.

Benchmark = Maxwell benchmark number (higher means faster rendering).

The benchmark number is scene dependant.

Image Update Interval

MXCL updates the main image at every new SL reached when the render has just been started. If
the next SL level takes more than 10 minutes to complete, MXCL continues to updated the image
every 10 minutes instead of the next SL, showing the incremental SL reached.

CONSOLE TAB

This panel provide information about the rendering process, scene statistics, etc. Any error or
warning messages are also displayed in the Console tab. If your scene does not start to render,
look first in this panel for clues on what might be the problem.
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RENDER OPTIONS TAB

This panel shows the rendering options that can be adjusted in MXCL. Most of these options
can be set from the command line and have already been explained (see the Render Options in
MXST section on page 82), however we go over each option here as well, in particular the MXI/
Resume options which are specific to MXCL.

INPUT PARAMETERS:

MXS: Path and scene to render.

Time: Set the maximum render time (in minutes) for the render.

Sampling Level: Maximum sampling level required. This value controls the quality of the render.
As with the “render time” parameter, the higher the sampling level reached, the more accurate
the image obtained.

Threads: Shows the number of CPUs available to render.

Priority: Set Normal or Low priority for the render. Use Low priority when you want to work

at your computer while rendering. With Normal priority, your computer may become less
responsive when performing other tasks. The difference in render time between using Normal or
Low priority is very small. For this reason it is recommended to use Low priority when rendering,
in case you want to come back to the computer at a later time to work in other tasks.

OUTPUT SETTINGS:

Image: Path and file type of final image.
Resolution: Size of the final image.
Lock Aspect Ratio: To maintain the proportions of the image.

ANIMATION:

The user specifies a range of mxs frames to be rendered. For example: 5,8,9 will render frames
name0005.mxs, name0008.mxs and name0009.mxs. To render frames 1 through 10, write 1-10.
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Render Options Tab

min Sampling Level 25 < Theads 2

Pririty

Image

Resolution

Maxwell will finish the rendering process when one of these two
conditions “Render time” or “Sampling level” are met. If you want
to finish the render after a specific time, set a very high sampling
level, and conversely, if you want to reach a specific sampling
level, set a very high render time.
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RENDER OPTIONS TAB

-

Default Path i
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MXI:

Load/Save MX|: When loading a mxs scene in MXCL to be rendered for the first time, you can
specify an output path for the MXI file. If you do not specify an MXI, a “default.mxi” file will be
created in the Maxwell install directory.

If you are loading a mxs scene that has been rendered before, the MXI path for the previous render
will appear in this path. You can either leave it as it is, or specify a new MXI to be created.

In case you are loading an mxs file that has previously been rendered on another computer and
you wish to resume the render: the path to the MXI will no longer be correct, so you need to
browse to the new location of the previously saved MXI, select it and choose Yes when MXCL
asks if you wish to overwrite the MXI. Make sure to then check the Resume option.

Resume: Check this to resume a previously rendered scene, instead of starting a fresh render.

Multilight": Stores a bigger .mxi for using the Multilight™ feature. Note that when resuming a
render, the original render must have multi light already enabled, otherwise Multi Light will not be
available when resuming the render.

BITMAPS:

By checking this box you have control over the on or off function of the Bitmap. If you uncheck this
option, the scene will be rendered without textures. Disable bitmaps.

Default Path: Path where MXCL will look for textures and bitmaps.

CHANNELS:

Render: Output the main render image.

Alpha: Output an alpha image. Note that selecting opaque will render refractive objects as solid
white in alpha channel.

Shadow: Shadow Pass shows the cast shadows of the materials with the “Matte Shadow”
Flag enabled.
Object ID: Output multicoloured object silhouettes.

zBuffer: Output an image representing scene depth within the two values specified in Z buffer
range. The range is in meters.

Material ID: Output multicoloured object silhouettes.
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PREVIEW/MXI TAB

These controls can be altered in realtime while rendering (except for the SimuLens™ parameters), PREVI EW/MX| TAB
and also after a render is finished. The preview thumbnail to the left is updated in real-time when a -
“Tone Mapping” or “Camera” value is changed. Maxwell will update the main image using the last
edited values when the main image is refreshed (Update time is reached).

The MXI options are only available for adjusting MXI files, or LDR/HDR images for using as MXI
files in emitters. Adjusting the f-stop or intensity of the LDR/HDR images will change their intensity
when used in emitters.

CAMERA:

Film [SO: Sensibility of the film to light (the higher ISO the higher sensibility). N
Shutter (1/s): The shutter speed, specified in 1/ n of a second.

TONE MAPPING: PREVIEW/MX| TAB

Changes the dynamic range of the images.

N
Burn: Tone-mapping parameter that controls how fast the image is overexposed.
Monitor Gamma: Tone-mapping parameter that controls the monitor gamma of the output image.
Mxl : min Sampling Level ¢ <  Threads
f-Stop: Controls the aperture of the lens. It has effect in light intensity and not in depth of field. Priority
Intensity: Intensity of the emission map.
\, 4
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PREVIEW/MXI TAB

4 )

Aparum Meap

Obstace Map

Deffraction

Frequancy

Scatieding

Vignetting

APERTURE MAPS

=00

Examples of aperture maps.

OBSTACLE MAP EXAMPLE
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SIMULENS™:

Allows you to control the lens diffraction, lens scattering, and vignetting effects of the Maxwell
SimuLens™ system.

Diffraction Effects

Happens when light goes through small holes, causing interference patterns. Itis a very important
phenomenon in optics, as it explains why a perfect telescope (or microscope) cannot be built.
Light will always cause slight interference patterns because of the optical components used,
causing the visual “artifact” known as glare.

The diffraction effect can also be used on HDR images. Simply load it using the “File > Load
image” option and apply diffraction to it.

Aperture Map: The shape of the diaphragm will model the pattern of light that reaches the
film. For example, a circular diaphragm will create circular patterns; a hexagonal diaphragm will
create 6 light streaks. You can set the diaphragm shape using a black/white map (it can be a
colour one) called the aperture map. Note the examples on the left show a bigger white area for
clarity, in practice the white area should be smaller in regards to the black area.

Obstacle Map: Water drops, eyelashes, dirt, etc on the camera lens will also cause diffraction
effects. Again, a white/black map is needed. If you don’t want to use an obstacle map, you can
leave this path blank, you only need an aperture map for diffraction to work.

Diffraction: Controls diffraction/glare intensity.

Frequency: Controls the frequency of coloring in diffraction effect. Higher values will make the
patterns denser.

Scattering: Commonly known as bloom and happens when the light is scattered inside the lens
before reaching the film.

Vignetting: Vignetting is an artifact darkening the image through the edges due to camera
optics, now you can partially or completely remove it by dragging the slider from 1000 to O.

A\

The obstacle map and the aperture map, must both have the same resolution. The render resolution and the
maps do not necessarily need to have the same resolution, but the more similar they are in resolution, the less
diffraction distortion.
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MULTILIGHT™ TAB

Multilight™ is a very useful feature that allows you to interactively adjust the intensity of the emitters
in the scene and to alter the ISO and shutter after rendering is finished. The adjustments can be
keyframed and animated over time, and a sequence of images can be saved. This makes it a very
powerful tool as it allows you to save different images of the same scene under different lighting
conditions and even make lighting animations from only a single render.

The Multilight™ tab contains the Emixer, where you adjust intensity of the lights and can also animate
the ISO and Shutterspeed. Each emitter in the scene will be represented by a slider with the name of
the emitter, including the Sky (any of the available Sky options) and HDR/MXI environment.

The Emixer key framed sequence can also be saved as an .emixer file. This is useful if you have
several camera views of the same scene and you want to apply the same lighting animation to
other camera views.

Light Slider: Controls the intensity of the light. It has a text box for specifying the exact intensity.

S: Solo button, will set this light as the only visible light, muting all the others. An important thing
to remember is that the Solo buttons work on the principal of an audio sequencer. For example if
you have 20 lights in the scene, you can choose to Solo two lights. This is easier than having to
mute 18 lights if you only wish to see the influence of two of the lights.

M: Stands for mute and will switch off the current light source.

Max Frames: Maximum number of frames in the Emixer timeline.

VIDEO:

Save sequence: Saves a sequence of images which can then be made into a video using a
video editing application.

Load Emixer data: Loads an emixer sequence file.
Save Emixer data: Saves an emixer sequence file.

Example of Multilight™ editing from a single render. Transitions can be animated within MXCL.
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Multilight Tab / Emixer
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Animated Timeline

Creating a Keyframe

Grab the slider to set a keyframe at the desired time. Rightclick on the slider, set the keyframe and
adjust light values or turn them on and off.

Deleting a Keyframe

Go to the keyframe you want to delete, you will notice it is a keyframe because the slider will turn
orange. Rightclick on the slider and choose Delete Keyframe.

Playback Controls

Go the beginning of the timeline. @ .
Play the sequence (preview) with this button or press spacebar. @ .
Pause the animation with this button or press spacebar. @ .

> NETWORK TAB

Network tab gives access to users to the networking rendering controls in order to manage
jobs sent to the render farm. Please refer to page 117 to know how network rendering and this
particular tab work.
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COMMAND LINE FLAGS

MXCL is the standalone rendering engine and can be used either from command line, from
Maxwell Studio or from the 3D applications’ Maxwell plug-ins.

In order to check that Maxwell Render has been properly installed, type “mxcl” in a command
line window. MXCL Commands should be listed like in the image below (Windows OS):

WINDOWSvspstem32hemd_exe - mucl

Microsoft Windows [Version 5.2.37981
CC» Copyright 1985-2803 Microsoft Corp.

C:xDocuments and Settings“Administrator>mxcl

Num processzors: ¢ logical: 2, physical: 2 >
HAXYELL RENDER (M"R»>. Engine version Maxwell Render 1.5 RC1i g

SYNTAX: —mxs:name [-animation:A.B-C,.D-E{frames) | —al [-idcpu:id]l [—camera:name]

[-output:path | —ol [-bhitmaps:'path’ | —hl [-hitmap=:8 | -h:61
[-res:xRes x yRes | —r] [—time:minutes | —t]1 [-priority:low p:louwl
[-threads :numThreads | —th: { B8 for autodetect > 1 [-display | —-dl
[-zampling:‘s1* | —=]1 [-ml | ml:off | —multilight ! multilight:off]
[-nowait] [-server] [-manager] [-silent]
[-channels:r.a.s.m.o,.2{min.max?> | —chl [-mxi:path.resume | —-mxi:path.r]

Example: —mxs:c:“scene.mxs —res:648x488 —time:18 idcpu:ld —th:2 —d -a:3.17-32
—lip,=2¢(-B.3, 2.4 d>,c —oc woutput.jpyg —mxizc:nfile.mxi.»

NN\

Maxwell Render 1.5 User Manual PAGE 111



PAGE 112

Following are the MXCL Command Line Options:

-mxs:name

-animation: A;B-C;D
-a:A; B-C;D

-idcpu:id

-Camera:name

-output:filename
-o:filename

NN
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Specifies the full path and name of the scene file to
render (MXS).

Specifies a sequence of frames to render. This can be
provided in the form of individual frames separated by a
semicolon (3;5;7) or a range in the form A-B (from frame
A to frame B) or a combination of both.

Example: mxcl -mxs:scene.mxs —a:3;17-32

This option allows you to specify the cpu id number of the
computer you are rendering with. This way, the output
MXI file stays flagged and can be manually merged
with another MXI file of the same scene rendered in
another computer (tagged with this command as well).
This merging will result in a better quality output (higher
sampling level and less noise).

Specify the camera name you want to render from in
case it does not match with the active camera in your
MXS scene file.

Specifies the full path and name of the image file. By
default, Maxwell always saves a file ‘default.tga’ in the
output folder of the installation path. The file name can
refer to any of the multiple graphic formats supported
(tga, jpg, tif, png, etc). In case of sequences, the output
files will be numbered with a 4-digit suffix.

Example: mxcl -mxs:scene.mxs —o:c:\images\scene.jpg



-bitmaps:path Set an alternative folder path for bitmaps location.

-b:path If path is O (-bitmaps:0), Maxwell will discard all the
bitmaps.

-res:WxH Specifies the resolution of the render in pixels (W=width,

- WxH H=height).

Example: mxcl -mxs:scene.mxs —res:640x480

-time:M Specifies the time (M = minutes) that Maxwell is allowed

-tM to use to render every frame. This is a very interesting
feature. Maxwell can render the scene in a specified
amount of minutes, providing the best possible quality.

Example: mxcl -mxs:scene.mxs —time:10

-p:low Set Maxwell priority to low.

-priority:low

-threads:N Specifies the number of threads (N) that Maxwell is
-th:N allowed to use. Normally this should be equal to the

number of CPUs available in the system. By default, N
is the number of CPUs found in the system except in
cases where hyperthreading features are available.

NOTE: When N is 0 (-th:0), Maxwell uses the maximum number
of threads (processors) available.

-display Opens a window and displays the render in progress.

-d This option is also used when distributing render
tasks. For more information read the section related to
network rendering.
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-sampling:level
-s:level

This value establishes a quality level for the render. This
value is useful when you want to render a sequence
of frames using different hardware configurations.
If the quality level is reached before the “maximum
render time”, then the render ends. Alternatively, if the
maximum render time is reached before the sampling
level, the render also stops the calculus.

To have an idea of the image quality during the render
process, you can take a look at the command line
window, where the sampling level is being actualized
during the render process.

Enables Multilight™ function storing an mxi file with all
the emitters’ information.

-nowait

Returns control to the console after the render finishes.

-server

This option starts Maxwell in SERVER mode, allowing
distributed render tasks. For more information read the
section related to network rendering.

-manager

This option starts Maxwell in MANAGER mode, allowing
distributed render tasks. For more information read the
section related to network rendering.

- silent

Makes Maxwell Render™ in modes server or manager
to start directly minimized on the icon tray, instead of
opening the console window.
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-channels: r,a,ao,s,m,0,z<min,max>
-ch: r,a,a0,s,m,0,z<min,max>

-mxi:filename,resume
-mxi:filename,r

-rs:N

This option establishes the different layers that Maxwell
can export:

r: Render channel

a: Alpha channel

ao: Opaque alpha. This option will render refractive
objects as solid white in alpha channel.

s: Shadow channel

m: Material ID channel

o: Object ID channel

z: Z-Buffer channel. This option also requires two
additional values indicating distances from the camera.
The z value is then calculated by centering on the focal
point (distance 0).

Note that when the channel option is set, the r option should be
added to obtain the rendered image (if required).

When rendering, Maxwell writes a special MXI file that
contains information about the rendering process. MXI
is the high dynamic range Maxwell image format. this
allows the user to resume previously rendered work.
(Available in a next add-on)

If this switch is not used, it will use the same name and
path as the MXS scene. The resume option continues
the render from a previously saved MXI file. In order to
resume a previous render job and update the MXI file,

“

,r” option must be added.

NOTE: The MXI file is useful to resume the rendering process
later, to use Multilight™ (when Multilight™ option has also been
enabled) or use it as a light emission map.

Specifies the render engine to be used.
-rs:0 Preview Engine.
-rs:1 Production Engine (by default).
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> NETWORK RENDERING

FIRST OF ALL, IT IS EASY!
UNDERSTANDING NETWORK

In order to initialize network rendering, you need to know about the network components of
Maxwell Render.

NOTE: Hybrid Networking: Mac, PC and Linux can work together in the same network even for
cooperative rendering.

THE NETWORK COMPONENTS ARE:
SERVER(S): USAGE

Responsible for rendering on every node. Each node can run one server at a time. Running mxcl.
exe with —server turns a computer into a render node. So, you should start a server on every
single computer you want to make a render with.

mxcl.exe -server
(optionally you can add -silent switch for starting minimized at task bar)

MANAGER:

Responsible for managing the render queue and distributing jobs among the network. Manager is
the most comprehensive and sophisticated component of Maxwell Network which works silently in
the backgrund. Running mxcl.exe with -manager switch on your computer is enough to initialize a mixcl.exe -manager

manager in a renderfarm.Be careful, you should run only one session of manager in a renderfarm (optionally you can add -silent switch for starting minimized at task bar)
and take into account that a manager can also be a server.
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mxcl.exe -d

RENDER FARM

Group

Dngraup
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VIEWER:

Also called Maxwell Display, it's responsible for user interaction with Maxwell Render network.
Viewer is the user-end frontface for managing every task in a network. Running mxcl.exe with -d
switch on a computer is enough to bring you the viewer interface. Network can be reached under
the tab with the same name located in the viewer. Right after launching servers per rendernodes
and launching a single manager session on one of your nodes, you can start the viewer and hit the
“Connect” button to start rendering on network. Hitting the Connect button will automatically scan
the network for a running manager and the servers. You can run viewer on as many computers as
you wish, even at the same time but not on the same node more than one session.

RENDER FARM:

Right after automatic detection of the manager on your network, the viewer will list the servers in
the Render Farm window. If they are available and ready to render, their state will be “Ready” You
can make server groups by selecting multiple servers from the list and hitting the group button.
Thus, you can send a job to a group of servers and another job to the others.

NOTE: If there is a server enabled but it is not available at the Render Farm,
revise your network connections.

JOB QUEUE:

Job Queue window will list the running/queued jobs you've sent to the renderfarm. You can “Add”
more jobs, stop or remove them. It's the heart of network jobs management where you can
monitor every single detail about ongoing progress.
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JOBS
ADDING JOBS:

Hitting “Add” button will bring you the Add Job panel which allows you to define several parameters
about the job to be added. First of all you need to select the scene to be rendered. Priority value
lets you set a queue priority which helps you insert jobs prior to the ones which have already been
sent to queue. The Render Farm window will show you selected servers to be used for the job.
You can still select The All Available checkbox and send the job to all available servers waiting to
render. Render options button will let you redifine the detailed scene parameters such as save
options or resolution etc. Hitting OK will add the job to the queue and if the assigned servers are
available, the manager will immediately distribute the information silently in the background and
the rendering process will start. During distribution of jobs, you can monitor every single action
per-node in realtime.

DISPLAYING JOBS:

One of the most powerful functions of the Job Queue window is the Display function. While servers
are rendering you can select any of them and when you hit Display button it will automatically
reveal the image being rendered on that node. Display button also supports instantaneous viewing
of a cooperative job as merged during the render progress. A green dot will help you identify a
display tab which has recently had an update from the remote node.

To learn more about render options please see the chapter on MXCL at page 82.
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COOPERATIVE RENDER
MAKING A COOPERATIVE RENDER:

Cooperative mode is a special mode that allows selected servers to work on the same frame
individually and to merge the images they've created at the end of the rendering process.
Activating cooperative mode is as easy as selecting the “Cooperative” checkbox in the Add Job
panel. Max Servers will let you limit the amount of Maxwell servers to be engaged for a single
frame. While rendering, multiple nodes will render the same frame with a different entropy
seed. When the job is finished, the manager will collect these results and merge them into a
single output file. It is possible to preview cooperative jobs during the render by selecting the
job tree and pressing the “Display” button.

NOTE: An output MXI must be specified as this will be the final merged file.

If the network fails or crashes at some point and the merging of MXI files is not completed,
you could try to manually merge the cooperative. MXI files created during the render process.
In this case, some of these cooperative .MXI files could give an idcpu warning; just ignore the
message and continue merging the rest of files. The file that gave an error should be ignored
because it was merged before the crash, and therefore taken into the account. Locate each
cooperative .MXI file in the temp directory of the operating system of each render node.

NN

Maxwell Render 1.5 User Manual



+ NEW MXI
MXI \
e FINAL MXI —

MMXI

\mmxu / FINAL RENDER
MXI \+ NEW MXI

+ NEW MXI
MXI

Note: It is strongly advised that there is only one Manager activated.

MANAGER

MAKING COOPERATIVE RENDERS MANUALLY:

In order to make a cooperative render manually you have to tag the output MXI file with the id
number of the cpu (via -idcpu command, check the command line flags for details on page 111).
This will assign an entropy seed to the MXI file that will be different from another MXI rendered
in another computer.

Once this is done, you can use File > Merge to select a folder where all these MXI files are
located, and specify an output final MXI file that will have a higher sampling level than any of the
individual renders (higher sampling level = less noise).

NOTE: In order to put all cooperative .MXI files together in a single folder, you will have to rename them and collect
them from their respective computers. Locate each cooperative .MXI file in the temp directory of the operating system

of each render node.

Select File > Load MXI and pick the merged MXI file that was just created. Once this file is loaded
you can adjust it and make the appropiate adjustments in Camera, Tone Mapping, MXI and
Simulens™. Once these adjustments are made you can save out an image file by selecting File >
Save Image or an MXI file by File > Save MXI.
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MAKE SURE:
You don't have firewall restrictions prior to initializing the Maxwell
network.

AT FIRST:
Make simple and successful tests on your network prior to
attempting final rendering.

ALWAYS USE:
Networked paths for everything possible, especially for output files.

PAGE 121



OPTIONS

-

0K

Cancel

RENDER FARM BUTTONS

-

Group Ungroup

PAGE 122

RENDERING AN ANIMATION

Maxwell Render is capable of rendering animations. There is no problem of flickering in contours
or textures. The only thing needed is a sequence of MXS files, that can be obtained via the
specific plug-in you are using.

Once all the frames have been exported into individual MXS files from your host application, you
have to add a job to the job queue (please refer to page 118) choosing any of the files of the MXS
sequence. Make sure you display all Render Options and type the sequence of frames you want
to render, otherwise you will only get the selected MXS rendered. Remember you can also render

single frames from the same sequence by using a semi-colon “;” when typing.

Example: 1-10;12;20-23

OPTIONS

This small panel provides some options about handling servers. For some reason (disconnection,
power failures etc) servers may go offline and it may take some time before they become availale
again or they may stay offline forever. So, Server Timeout value lets you set max time in seconds
to wait before discarding the unavailable server and proceed to the next. Since the chain of failures
may last longer than expected, there is a “Try Next” variable to limit the number of forwarding
actions. By default, it's three (3), which means any job failed after three times of forwarding by
every 60 sec timeout per each node will be given up.

RENDER FARM BUTTONS
Group

You can select multiple servers by Shift or CTRL key combination and make a group from them. So
later you can select multiple machines by selecting the group tree and send them jobs quickly.

Ungroup

Clicking Ungroup with a group tree selection will unchain all the servers in that group. If you do
the same with selection of server(s) which are member of a group, it will only detach them from
the group.

Add

Clicking Add will let you add a server manually by entering its IP address. That could be a server
having a different range of IP than already autodetected.
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TIPS

Network and Distributed rendering won’t work properly unless the MXS and MXM files are
accessible to all render nodes. You must set up a shared folder in which to save these files that
each node can see and read the data from. You will also need a shared folder that each node
can write its data to.

NOTE: If you have more than ten render nodes all of these folders need to be set up on a machine that is running

Windows Server because any other version of Windows will only allow ten simultaneous connections at any given time.

When doing animations make sure that you have plenty of hard drive space, each MXS file can
easily be 100+ MB in size and will quickly fill up a small drive.
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B 62

BASICS MENU 30
BASIC LAYER 32
BITMAPS 106
BLENDING MODES 35

BLOW UP 95

BOTTOM

D 62

BOUNDING BOX 63

BROWSER

Material Browser Panel 76

BROWSER

Material Browser 40

BSDF 29, 30, 32, 38, 39, 41,
47,48, 49,53, 54, 55

BUFFERS

Vertex Buffers 64

BUTTONS

Render Farm Buttons 122

Viewports 62
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CAMERA 107
Block/Unblock 79
Camera Frustum 65
Camera List 60
CAMERA LIST PANEL 79
Camera Parameters 60
Clone 79

Creating a Camera 64
Delete 79

Depth of Field 66

FPS 78

Hide/Unhide 79

lcon Size 79

ltems 79

Make Active 79
Moving a Camera 65
New Camera 79
Offset 69

Rename 79

Rotary Disc Shutter 78
Shift Lens 69

Shutter 107

Shutter Angle 78
Z-Clip Planes 69

CAMERA FRUSTUM 65
CAMERA LIST 60, 64, 65

CAMERA LIST PANEL 78, 79
Block/Unblock 79
CAMERA LIST PANEL 79
Clone 79

Delete 79

Hide/Unhide 79

|con Size 79

ltems /9

LIST PANEL 79

Make active 79

New Camera /9
Rename 79
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CAMERA PARAMETERS 60, 65

CAMERA PARAMETERS PANEL 77
Diaphragm 78

Optics 77

Position 77

Resolution 77

Shutter Angle 78

CAUSTICS LAYERS 84
CENTER SCENE 61
CENTER SELECTION 61

CHANNEL 38
Channel ID 91
UV Set 91

CHANNELID 91
CLIPMAPS 7, 55
Transmittance 55
CLONE 71,75,79
COATING 32, 47

COATING PROPERTIES 47
PROPERTIES 47/
Thickness 47

COLLAPSE ALL 90
COLLAPSE SELECTED 90
COLLAPSING A PANEL 59

COLOUR 28, 39, 46, 49, 50
Correlated Colour 50

Display Preferences 64

Set Colour 79

COLOUR AND LUMINANCE
llluminance 51

Load Preset 51

Luminous Intensity 51
Temperature 51

COLOUR CHIPS 46
COLOUR PICKER 39, 41, 42, 50

COMMAND LINE 83
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COMMAND LINE FLAGS 111
COMPASS 81

COMPONENTS 41
BSDF PROPERTIES 41

CONSOLE 9, 60, 104
CONSOLE TAB 104

CONTROLS
Playback Controls 110

COOPERATIVE MXI' 103
COOPERATIVE RENDER 120
CORRELATED COLOUR 50
CPU THREADS 82

CREATING

A CAMERA 7, 64

A KEYFRAME 110

A NEW MATERIAL 92
ANEW UV SET 91

CUSTOMIZABLE LAYOUT 57
CUSTOMIZING THE LAYOUT 58
Opening a Layout 59

Quick Switching 59

Saving a Layout 59

CUSTOM ND 44

(0]

D 62
DATE 80

DEFAULT
Custom Layout 59

DEFAULT PATH 106
DELETING A KEYFRAME 110
DEPTH OF FIELD 7, 66, 67
DESELECT ALL 71
DIAPHRAGM 78
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DIFFRACTION EFFECTS 108
Diffraction 108
Frequency 108
Scattering 108
Vignetting 108
DIFFUSE 26

DISABLING
Enabling/Disabling Textures 93
DISPERSION 45

DISPLAY

Display Preferences 64
DISPLAYING JOBS 119

DISPLAY MODES 7, 62, 63
Bounding Box 63

Flat 63

Hidden Line 63

Shaded 43

Textured 63

Texture Decal 63

Toon 63

Viewport Grid 63

Wireframe 63

DISPLAY PREFERENCES 7, 64
Enable Sky 64

Set Colour 64

Smooth Antialiasing 64
Threshold 64

Vertex Buffers 64

DISPLAY SECTION 73

DOF
Depth of Field 66

DOWN
D 62

DRAG AND DROP 39
DXF IMPORT OPTIONS 99
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EFFECTS
Diffraction Effects 108

EFFICACY 50
EMBED MXM 33
EMISSION 51

Temperature 51

EMITTER
New Emitter 75

EMITTER PROPERTIES 49, 52
Input 49

ENABLED
MultiLight™ 83
ENABLING/DISABLING TEXTURES 93

ENVIRONMENT SETTINGS 60, 79
Atmosphere 80

Compass 81

Image Based 81

Location Time Panel 80

Ozone 80

Physical Sky 79

Set Colour 79

Sky Dome 79

ENVIRONMENT SETTINGS 60, 79
Sky Globe 81

Sun 80

Turbidity 80

Water 80

ENVIRONMENT SETTINGS PANEL 79
EXIT 104

EXPAND 89
ALL 90
SELECTED 90

EXPORT MATERIAL 30

(¥

F 62
F-STOP 107
F10 89
F11 89

F2 93

F8 89

F? 89

FACE
Front-Face Polygon 89

FAR 69
FARM

Render Farm 118
Render Farm Buttons 122

FILE MENU 30, 103
Cooperative MXI 103
Exit 104

Load Image 103

Open MXI 103

Open MXS 103

Save Image 104

Save MXI' 103

FILM ISO 107
FLAGS

COMMAND LINE FLAGS 111
FLAT 63, 74
FLOATING PANEL 58
FORMATS 51

FPS 78

FRAME

Camera Frustum 65
FRESNEL 27
FRONT

F 62

FRONT-FACE POLYGON 89

FRUSTUM
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Camera 65
FUNCTION KEY
F11 89

F8 89

F9 89
FUNCTION KEY
F10 89
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GAMMA
Monitor Gamma 107

GENERAL 82
Caustics Layers 84
CPU Threads 82
lllumination Layers 84
IMG 83

MultiLight™ 83

MXI 83

Render Layers 84
Time 82

Viewport Preview 85

GEOMETRY SECTION 73

GLASS 12,27,32, 33, 35, 41, 43, 46, 53, 55

Refl 0° 53
Roughness 53
GLOBE

Sky Globe 81
GRID

Grid Scale 63
Viewport Grid 63

GROUP 71, 89, 90, , 122,
GROUPS

Assigning Materials to Groups 93

Collapse All 90
Collapse Selected 90
Expand All 90

Expand Selected 90
Triangle Groups 75
Working with Groups 89
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GROUP TRIANGLES 71

(H]

HIDDEN LINE 63
HIDE/UNHIDE 72, 79
HISTORY 7, 20, 60, 85
HISTORY PANEL 85

[

ICON SIZE 72,76, 79
D
Channel ID 91

ILLUMINANCE 51
MXI Texture 51

ILLUMINATION LAYERS 84
IMAGE 105

IMAGE BASED 81

IMG 83

IMPORTING A MATERIAL 92
IMPORTING OBJECTS 9, 87
IMPORT MXM 75

IMPORT OBJECT 57

IMPORT OPTIONS 98
DXF Import Options 99
MXS Import Options 98
OBJ Import Options 99

INPUT 44, 49, 105
INPUT PARAMETERS 105

INTENSITY 51,81, 107

Luminous Intensity 51
INVERT 38, 72, 99
INVERT TEXTURE 38

IOR FILES 45, 47, 55, 96
Water 4/

ITEMS 72
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JOBS

Adding Jobs 119
Displaying Jobs 119
JOB QUEUE 118

(1]

KEY

* Key 89

- Key 89

/ Key 89

F10 89

F11 89

F8 89

F9 89

KEYFRAME

Creating a Keyframe 110
Deleting a Keyframe 110

L)

L 62
LAMBERTIAN 26, 44

LATITUDE 80

LAYERS

Add Subsurface 32
BLENDING MODES 35
Caustics Layers 84
lllumination Layers 84
Remove Layer 33

Render Layers 84

LAYER WEIGHTING 34
LAYOUT

Opening a layout 59
Setting a custom layout 59
LAYOUTS

Quick Switching 59
Saving a Layout 59

LEFT
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L 62

LIBRARIES 9, 57, 87
Preset Obiject Libraries 87
LIGHT

REFLECTED LIGHT 26
LIST

Camera List 60

Material List 60

Obiject List 60

LOAD/SAVE MXI 106
LOAD FILE 45

LOAD FULL IOR DATA 45
LOAD IMAGE 103

LOAD PRESET 51
LOCATION TIME

Date 80

Latitude 80

Longitude 80

LOCATION TIME PANEL 80
LOCK ASPECT RATIO 105
LONGITUDE 80

LOOK AT SELECTION 61

LUMINANCE 49, 50, 51
Efficacy 50

Luminous Power 50
Watts 50

LUMINOUS INTENSITY 51
LUMINOUS POWER 50

()

MAKE ACTIVE 79

MANAGER 117
MAPPING

Tone Mapping 107

MAPS AND TEXTURES 91
MATERIAL



Assigning Material to a Single Objects 92
Clone Material 75

Creating a New Material 92

Importing a Material 92

New Material 75

Renaming a Material 93

MATERIALS 25, 41, 53
Abbe 45

Attenuation distance 43
BSDF 55

Clipmaps 55
COMPONENTS 41
Custom Nd 44
DIFFUSE 26

FRESNEL 27

Glass 53

IOR Files 47
Lambertian 44

Material Browser 40
Material Editor 40
Material List 460
Material Properties 41
Plastic 54

Refl 0° 53

Reflectance 41
MATERIALS 25, 41, 53
REFLECTED LIGHT 26
Shiny 54

SPECULAR 26
TEXTURING AND ASSIGNING MATERIALS 91
Thickness 47/
Transmittance 55

TRANSPARENCY 27

MATERIALS 100
Assigning Materials to Groups 93
Assigning Materials to Triangles 93

MATERIAL BROWSER 60, 76, 100
MATERIAL BROWSER PANEL 76
MATERIAL COMPONENTS 29
MATERIAL EDITOR 29

BASICS MENU 30
BLENDING MODES 35
Colour PICKER 39
DRAG AND DROP 39
Export Material 30
Extract Materials 30

FILE MENU 30

LAYER WEIGHTING 34
Material Components 29
MATERIAL LAYERS 32
MATERIAL PREVIEW 37
Material Preview 29
Material Properties 29
New MXM 30

Open Material 30
Shadow Pass 36

Surface Properties 29
WIZARDS MENU 31
MATERIAL EDITOR 44, 60
MATERIAL ID 106
MATERIAL LAYERS 32
Adding Layers 32

Add Basic Layer 32

Add Coating 32
MATERIAL LAYERS 32
Add Emitter 32

Basic Layer 32

BSDF 32

Coating 32

Removing Layers 32

SSS 32

MATERIAL LIST 60, 75,77, 89, 93, 100
MATERIAL LIST PANEL 75
Clone Material 75
Import MXM 75

New Emitter 75

New Material 75
Rename Material 75

MATERIAL PREVIEW 37
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MATERIAL PREVIEW 29

MATERIAL PROPERTIES 29, 41
COATING PROPERTIES 47
Colour Picker 41

Load File 45

Load full IOR data 45
Roughness 46

Transmittance 42

MATERIAL SELECTION 89

MAXWELL RENDER 103, 104
Console Tab 104

Cooperative MXI 103

Exit 104

FILE MENU 103

Load Image 103

Open MXI' 103

Open MXS 103

Render Options Tab 105
Render Status Bar 104

Save Image 104

Save MXI' 103

VIEWER 103

MAXWELL STUDIO

Apply textures 57
CUSTOMIZING THE LAYOUT 58
Import object 57

MENU
Selection Menu 89

MERGE OBJECTS 9, 72, 90

MODES
BLENDING MODES 35

MODES
Display Modes 63
Selection Modes 89

MONITOR GAMMA 107
MOVE 88

MOVING A CAMERA 7, 65
MOVING PANELS 58
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MULTILIGHT™ 83, 106, 109 Resume 106 NETWORK TAB 110

MULTIPLE CAMERAS 57 zBuffer 106 NEW CAMERA 79
MXCL MXI TEXTURE 51 NEW EMITTER 75
Animated Timeline 110 MXM
COMMAND LINE FLAGS 111 Import MXM. 75 NEW MATERIAL 75
Console Tab 104 NEW MXM 30
New MXM 30
Cooperative MXI 103 NEW UV SET 71
Creating a Keyframe 110 MXS 105 Creating a new UV Set 91
Deleting a Keyframe 110 MXST NUMERICAL INPUTS 60, 88
Exit 104 Apply textures 57 '
f-Stop 107 Customizable Layout 57 @
FILE MENU 103 CUSTOMIZING THE LAYOUT 58
Intensity 10/ Import object 57 OBJECT
I{:/T,Z)O(l\/l\/rEEI?EEI]\J%gER o Libraries 57 Obiject Parameters 60
Materials 100 . ) )
Monitor Gamma 107 Multiple Cameras 57 Selecting by using a region 88
MXI 107 MXS Import Options 98 OBJECTS .
Ne’rwork TGb 110 PREFERENCES 97 |mpor1|ng Ob|ecfs 87
Playback Controls 110 Preview 100 Merge Objects /2, 90
PREVIEW/MXI TAB 107 Shortcuts 99 Preset Qbiecf Librories 87
Render Options Tab 105 Sky Opfi 57 Renaming Ob.|ec’rs 87
Render Status Bar 104 y Zprons Replacing Objects 8/
Save Image 104 MXS IMPORT OPTIONS 98 Selecting Objects 88
Sending the Scene to MXCL Render/Viewer 95 @ OBJECTID 106
Shutter 107
Simulens™ 108 OBJECT LIST 60

NAVIGATION 7, 61

Center Scene 61

Tone Mapping 107 OBJECT LIST PANEL 71,72

Video 109 : Assign Material 71
VIEWER 103 E:enlzer Selechpn 61 Clone 71

ook at Selection 61 Deselect All 71
MXI' 83, 106, 107 Reset Viewport 61 Dfasel ecS s
Alpha 106 Rightclicking &1 Glspoy ecsf|oq .
Bitmaps 106 NEAR 67 69 eometry Section
Cooperative MXI 103 ’ Group 7‘1
Default Path 106 NETWORK RENDERING 117 Group Triangles 71
|nfensify 107 Addihg Jobs 119 Hide/Unhide 72
Load/Save MXI 1064 Displaying Jobs 119 lcon Size 72
Material ID 106 Job Queue 118 Invert 72
Multilight™ 106 MANAGER 117 ltems 72
Object ID 106 Render Farm 118 MATERIAL LIST PANEL 75
PREVIEW/MXI TAB 107 SERVER 117 Merge Obijects 72
Render 106 Viewer 118 New UV Set 71
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OBJECT PARAMETERS 73
Pivot Section 73

Remove /2

Rename /2

Select All 71

Triangle Groups 75
Ungroup 71

Unhide All 72

UV Parameters /74

UV Sets Section 74

OBJECT PARAMETERS 20, 60, 71,
73,74,88, 91

OBJECT SELECTION 89

OBJ IMPORT OPTIONS 99

OFFSET 38, 69, 81

OFFSET TEXTURE 38

OPENING A LAYOUT 59

OPENGL® 98

Appearance 98

Performance 98

OPEN MATERIAL 30

OPEN MXI 103

OPEN MXS 103

OPTICS 77

OPTIONS 122

Render Options 60
OPTIONS PANEL

RENDER OPTIONS PANEL 82
OPTIONS TAB

Render Options Tab 105
OUTPUT 83

Command Line 83

IMG 83

OUTPUT SETTINGS 105
Image 105
Lock Aspect Ratio 105

Resolution 105
OZONE 80

(7]

PACK AND GO 95
PAINT POLYGON SELECTION 89

PANELS 20, 58, 59, 60, 97
Collapsing a Panel 59

Floating Panel 58

Moving Panels 58

Opening a new floating panel 58
Preferences 96

Removing a Panel 58

Saving a Layout 59

Splitting a Panel 58

Undocking Panels 58

PANEL TYPES 7, 60, 71, 88
2D Viewport 60

3D Viewport 60

Assign Material 71
Atmosphere 80
Camera List 60
Camera Parameters 60
Clone 71

Console 460

Deselect All 71

Display Section 73
Environment Settings 60
ENVIRONMENT SETTINGS PANEL 79
General 82

Geometry Section 73
Group /1

Group Triangles 71
Hide/Unhide 72
History 60

History Panel 85

lcon Size 72

Invert 72

ltems /2

Location Time Panel 80
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Material Browser 60
MATERIAL BROWSER Panel 76
Material Editor 60
Material List 60
MATERIAL LIST PANEL 75
Merge Obijects 72
Navigation 61

New UV Set 71
Numerical Inputs 60
Object List 60

OBJECT LIST PANEL 71
OBJECT PARAMETERS 73
Object Parameters 60
Output 83

Pivot Section 73
Remove /2

Rename /2

Render Options 60
RENDER OPTIONS PANEL 82
Reset Viewport 61
Rightclicking 61

Select All 71

Triangle Groups 75
Ungroup 71

Unhide All 72

UV Parameters /4

UV Sets Section 74
VIEWPORTS 61
PARAMETERS

Camera Parameters 60
Obiject Parameters 60
Rotary Disc Shutter 78
PATHS 97

PERFORMANCE 98
PERSPECTIVE 60, 62
PHYSICAL SKY 20, 79, 82
PIVOT SECTION 73
PLASTIC 7,30, 54, 72

PLAYBACK CONTROLS 110
POLYGON
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Front-Face Polygon 89
Paint Polygon Selection 89
Raycast Polygon 89

POSITION 77

PREFERENCES 96
Appearance 97

DXF Import Options 99
General 97

Import Options 98
Materials 100

OBJ Import Options 99
OpenGL™ 98

Paths 97

Performance 98
Preview 100

Shortcuts 99

Warnings 97
PREFERENCES
Display Preferences 64

PRESET OBJECT LIBRARIES 87

PREVIEW 95, 100
Viewport Preview 85

PREVIEW/MXI TAB 107
Camera 107

f-Stop 107

Film ISO 107

Intensity 107

Monitor Gamma 107
MXI 107

Shutter 107

Simulens™ 108

Tone Mapping 107
PREVIEW OPTIONS 29, 37
PRIORITY 105
PROPERTIES

Emitter 49

PROPERTIES
Subsurface Scattering 48
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QUEUE
Job Queue 118

QUICK SWITCHING 59

(7]

R 62

RAYCAST POLYGON 89

REAL SCALE 38

REFL 0° 53, 54

REFLECTANCE 41, 42, 44, 45, 46, 51

REFLECTED LIGHT 26
REGION
Selecting a Region 88

REMOVE 33, 47,72,75,76,
REMOVE LAYER 33, 47
REMOVING A PANEL 58
REMOVING LAYERS 32
RENAME 72,75, 79
RENAME MATERIAL 75

RENAMING A MATERIAL 93
F2 93

RENAMING OBJECTS 9, 87
RENDER

Cooperative Render 120

Render Options 60

RENDERING 94

BLOW UP 95

Pack and Go 95

RENDERING

Network Rendering 117

Sending the Scene to MXCL Render/Viewer 95

Viewport Rendering 95
RENDERING AN ANIMATION 122
RENDER FARM 118
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Options 122
RENDER FARM BUTTONS 122
RENDER CHANNELS 22, 84

RENDER OPTIONS 9, 36, 60, 95, 105,119
Caustics Layers 84

lllumination Layers 84

IMG 83

MultiLight™ 83

MXI 83

Output 83

Render Layers 84

Viewport Preview 85

RENDER OPTIONS PANEL 82, 83, 84
Caustics Layers 84
CPU Threads 82
General 82
lllumination Layers 84
MultiLight™ 83

MXI 83

Output 83

Render Layers 84
Time 82

Viewport Preview 85

RENDER OPTIONS TAB 105
Alpha 106
Animation 105
Bitmaps 106

Default Path 106
Image 105

Input parameters 105
Load/Save MXI 106
Lock Aspect Ratio 105
Material ID 106
MultiLight™ 106

MXI 106

MXS 105

Obiject ID 106
Output Settings 105
Priority 105

Render 106



Resolution 105
Resume 106
Sampling Level 105
Threads 105

Time 105

zBuffer 106

RENDER STATUS BAR 104
REPLACING OBJECTS 87
RESET LAYER 33

RESET VIEWPORT 61
RESOLUTION 77, 83, 105

RESUME 106
RIGHT
R 62

RIGHTCLICKING 61

ROTARY DISC SHUTTER 78
FPS 78
Shutter Angle 78

ROTATE 88
ROUGHNESS 46, 53

8

SAMPLING LEVEL 105
SAVE IMAGE 104
SAVE MXI 103
SAVING A LAYOUT 59

SCALE 88

Real Scale 38

SCATTERING 48, 108
SCENE

Center Scene 61

Enable Sky 64

SELECTED

Collapse Selected 90
Expand Selected 90
SELECTING A REGION 88

SELECTING OBJECTS 88

SELECTION

Center Selection 61

Look at Selection 61
Material Selection 89
Object Selection 89
Triangle Selection 89
SELECTION MENU 89
* Key 89

+ Key 89

- Key 89

/ Key 89

Expand 89

F10 89

F11 89

F8 89

F9 89

Front-Face Polygon 89
Paint Polygon Selection 89
Raycast Polygon 89
SELECTION MODES 89

SELECT ALL 71
SENDING THE SCENE MXCL RENDER/

VIEWER 95

SERVER 117

SETTING A CUSTOM LAYOUT 59
SET COLOUR 64, 79, 98
SHADED 62, 63

SHADOW CHANNEL 29, 36
SHIFT LENS 7, 18, 69
Offset 69

SHINY 54
SHORTCUTS 99

SHUTTER 107
Rotary Disc Shutter 78

SHUTTER ANGLE 78
SIMULENS™ 108

SKY 64
Physical Sky 79
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Sky Globe 81

SKY DOME 79

Set Colour 79

SKY GLOBE 81

SKY OPTIONS 57

SMOQOTH ANTIALIASING 64
SPECULAR 26

SPLITTING A PANEL 58

SSS 29, 32, 48

STOP

f-Stop 107

SUBSURFACE SCATTERING 48, 49
Absorption 48

SUN 80, 81

SURFACE PROPERTIES 29, 41, 46

Anisotropy 46
Roughness 46

(7]

T 62

TAB

Console Tab 104
Multilight™ 109

MXI 106

Network Tab 110

Render Options Tab 105
Video 109
TEMPERATURE 49, 50, 51

Emission 51

TEXTURE

Additional Texture Options 93
Texture Decal 63

TEXTURED 63

TEXTURES

Enabling/Disabling Textures 93
Maps and Textures 91

TEXTURE DECAL 63
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TEXTURE PICKER 38
Channel 38

Channel ID 91

Invert texture 38
Loadding a texture 38
Offset texture 38

Real Scale 38

Tiling Options 38
Unloading a texture 38
TEXTURING & ASSIGNING MATERIALS 91
Maps and Textures 91

THICKNESS 47

THREADS 105
CPU Threads 82

THRESHOLD 64, 98

TIME 82, 105
TIME PANEL

Location Time Panel 80
TONE MAPPING 107

TOON 63
TOP
T 62

TRANSMITTANCE 42, 43, 46, 48, 53, 55

TRANSPARENCY 27
TRIANGLES

Assigning Materials to Triangles 93
Group Triangles 71

TRIANGLE GROUPS 75
TRIANGLE SELECTION 89

TURBIDITY 80
TYPE

Image Based 81
Sky Globe 81

(Y]

UNDOCKING PANELS 58
UNGROUP 71,90, , 122,
UNHIDE ALL 72
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UNLOADING A TEXTURE 38
UV PARAMETERS 74

UV SET 91

Adjusting a UV Set 92
UV SETS

Creating a new UV Set 91

UV SETS SECTION 74

VERTEX BUFFERS 64, 98

VIDEO 109

Animated Timeline 110
Creating a Keyframe 110
Deleting a Keyframe 110
Playback Controls 110
VIEWER 103,118
VIEWPORT

2D Viewport 60

Grid Scale 63

Reset Viewport 61
Viewport Grid 63
VIEWPORTS 61, 62
2D / 3D Viewports 62

B 42

D 62

F 62

L 62

Perspective 62

R 62

Shaded 62

T 62

3D Viewport 60
VIEWPORT GRID 63
VIEWPORT PREVIEW 85
VIEWPORT RENDERING 95

Sending the Scene to MXCL Render/Viewer 95
VIEWS

Bounding Box 63

Flat 63
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Hidden Line 63
Shaded 43
Textured 63
Texture Decal 63
Toon 63
Wireframe 63

VIGNETTING

W)

WARNINGS 97
WATER 47, 80, 108
WATTS 50
WEIGHTING 34
WIREFRAME 63, 68
WIZARDS 31
WIZARDS MENU 31

WORKING WITH GROUPS 89
Collapse All 90

Collapse Selected 90

Expand All 90

Expand Selected 90

Group 90

Ungroup 90

YELLOW FRAME

Camera Frustum 65

]

Z-CLIP PLANES 18, 69
Far 69
Near 69

ZBUFFER 106

108



(SYMBOLS |

*KEY 89

+ KEY 89

- KEY 89

/ KEY 89

2D

2D / 3D Viewports 62
Grid Scale 63

2D / 3D VIEWPORTS 62
3D 62

B 62

Bounding Box 63

D 62

F 62

Flat 63

Hidden Line 63

L 62

Perspective 62

R 62

Shaded 62, 63

T 62

Textured 63
Texture Decal 63
Toon 63

Wireframe 63
2D VIEWPORT 60, 61

3D 62
2D / 3D Viewports 62
3D 62

3D VIEWPORT 60
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SHORTCUTS LIST

GENERAL

Open preferences Ctrl+Shift+O
Exit Studio Cirl+Q
Undo Ctrl+Z
Redo Ctrl+Shift+Z
VIEWPORT NAVIGATION

Rotate Alt+LMB
Pan Alt+MMB
Zoom Alt+RMB
Local rotate Alt+Shift+LMB
Roll Alt+Shift+ MMB
Local Zoom Alt+Shift+RMB
Slow rotate Ctrl+Alt+LMB
Slow pan Ctrl+Alt+MMB
Slow zoom Ctrl+Alt+RMB
VIEWPORTS

Display/Hide viewport info I
Display/Hide physical sky/HDR K
Cycle viewport shading type S
Display/Hide compass z
FILE

New Scene Ctrl+N
Open scene Ctrl+O
Import object Shift+1
Save scene Ctrl+S
Save scene as Ctrl+Shift+S
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SELECTION

Select object by keyword Ctrl+F
Select all objects Ctrl+A
Deselect all objects Esc
Hide/Unhide selected objects Ctrl+H
Cycle selection mode T
(OBJECT, GROUPS, TRIANGLES, MATERIALS, UVSETS)

Add to selection Shift+LMB
Remove from selection Ctrl+LMB
TRIANGLE SELECTION

Expand selection to connected region /
Expand selection +
Collapse selection -
Invert selection :
Expand selection to facet mode F8
Raycast selection mode Fo
Front-face selection mode F10
Paint selection mode F11
(HOLD SHIFT TO ADD TO SELECTION)

EDITING

Create clone Ctrl+D
Create group Ctrl+G
Move W
Rotate E
Scale R
Selection handles (All) Q
Delete Del
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CAMERAS
Create new camera Ctrl+C
Display camera handles L

(PRESS REPEATEDLY TO SWITCH FROM CAMERA HANDLES,
CAMERA TARGET HANDLES, CAMERA+TARGET HANDLES)

Autofocus F
PANELS

Viewport Cirl+1
Material Editor Ctrl+2
Material List Ctrl+3
Material Browser Ctrl+4
Obiject List Ctrl+5
Obiject Parameters Ctrl+6
Camera List Ctrl+7
Camera Parameters Ctrl+8
Environment Settings Ctrl+9
Render Options Ctrl+0
History Panel Alt+Ctrl+1
Console Panel Alt+Ctrl+2
RENDERING

Render to MXCL Ctrl+R
Preview render viewport Ctrl+P
Render viewport Ctrl+Shift+P



RESOURCES

MAXWELL RENDER

Next Limit's Maxwell Render official website, to keep you up to date with
Maxwell Render news.

HTTP://WWW.MAXWELLRENDER.COM

Next Limit's official MXM Gallery website. An invaluable resource for
Maxwell users — find more than 1000 ready to use and FREE Maxwell
materials in all sorts of categories. As a Maxwell user you too can contribute
by uploading your own materials to the site.

HTTP://MXMGALLERY.MAXWELLRENDER.COM/

A completely new site for Maxwell Render, a knowledge base featuring FAQ,
tutorials and other useful info (scheduled for Summer ‘07).
HTTP://THINK.MAXWELLRENDER.COM/

Next Limit's contributions to the new generation of rendering technology at
Maxwell Firsts (scheduled for Summer ‘07).
HTTP://FIRSTS.MAXWELLRENDER.COM

Maxwell Render official forum, where Maxwell Render users share their
knowledge, show their work and discuss about techniques, features and
more.

HTTP://WWW.MAXWELLRENDER.COM/FORUM/

OTHER NEXT LIMIT’S PRODUCTS

Next Limit’s official RealFlow4 website.
HTTP://WWW.REALFLOW.COM

Next Limit’s official XFlow website.
HTTP://WWW.NEXTLIMIT. COM/XFLOW/

NEXT LIMIT TECHNOLOGIES

Next Limit's official website (developers of Maxwell Render).
HTTP://WWW.NEXTLIMIT.COM

If you have any queries regarding Next Limit or any of its products, please
feel free to get in touch with us at the following addresses:

Sales & Marketing
HTTP://WWW.NEXTLIMIT.COM/SALES SUPPORT.HTM

Technical support
http://www.nextlimit.com/tech_support.htm

Training

HTTP://WWW.NEXTLIMIT.COM/TRAINING SUPPORT.HTM
NEXT LIMIT TECHNOLOGIES

C/ Angel Cavero, 2

28043 — Madrid (SPAIN)

Fax: +34 917 219 464
Europe Time Zone [+6H US Eastern time]

MAXWELL RENDER USER MANUAL

Manual Design by.
SOLID DESIGN

Manual Published by.
SOLID PUBLISHING

A HIGH QUALITY DIGITAL PRINT CAN BE PURCHASED FROM
HTTP://SOLIDPUBLISHING.COM/SHOPHTML
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